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GETTING STARTED 
To access the Mission Editor: In S.C.S. - Dangerous Waters’ Main Menu, click MISSION 
EDITOR to display the Mission Editor Region Selection interface. 

The S.C.S. - Dangerous Waters’ Mission Editor allows you to create single, campaign and 
multiplayer missions anywhere in the world! Ships and aircraft from seventeen countries as well as 
civilian platforms, buildings and environmental objects are available for placement in your 
scenarios. Here you can create scenarios that place a player in command of any of the following: 

US Platforms: Seawolf SSN class, 688(I) Improved Los Angeles SSN class, Oliver Hazard 
Perry FFG class, its MH-60R multi-mission helicopter, and a P-3C Orion Maritime Patrol 
aircraft.  
Russia: Improved Akula-I SSN and the Akula-II SSN, Kilo 877 SS and Improved Kilo 636 SS 
classes. 
People’s Republic Of China: Kilo 877 SS and Improved Kilo 636 SS classes. 

Use the Probability of Inclusion, Random Start Boxes, Dynamic Location and Dynamic Group 
features to create missions that play differently each time! 

This manual is divided into these sections: 
Getting Started: Covers creating the region of a new mission, loading an existing single or 
campaign mission, and importing a 688(I) Hunter/Killer, Jane’s Fleet Command, or Sub Command 
mission to convert it for use in S.C.S. - Dangerous Waters. 
Mission Creation: A brief overview of the interface and issues involved in creating single missions 
and campaign missions. 
Mission Map: The Mission Map, its readouts, menu, and tools. 
Mission Object Menu: The options available from an object’s right-click menu. 
Object Buttons: Adding a sub, ship, global trigger, land-based objects, and scripts to a mission. 
Editor Menu: Editor Menu options and their use. 
Scenario Browser: The Scenario Browser and its use. 
Object Properties Panel: Available object types are listed alphabetically and their Object 
Properties Panel pages are explained 
Triggers: Types of triggers and their uses, Trigger Precedence and Trigger Object Properties 
Panel pages. 
Scripts: The use of scripts and how to create them. 
Doctrine Language Editor: Brief overview on the use of doctrine language and how to use the 
Doctrine editor. 
Dynamic Groups: The use of Dynamic Groups to make scenarios play differently each time they 
are played. 
Mission Editor Hot Keys: Hot keys available in Mission Editor. 
Starting a Created Mission: Step-by-step instructions for saving and starting a created mission. 
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    Editor Menu                               Region Selection Map

 
Choose Region Cursor

 

9 Note: Whenever the term ‘click’ is used in this manual, it refers to a single left mouse click. 
Right mouse click indicates a single ‘right-click.’ 

CREATING A NEW MISSION  
To create a new mission you must first select a region on the world map as the mission’s location. 
A region is a 600 by 600 nautical mile square centered on a specific longitude and latitude 
designated by the Choose Region cursor. 

Selecting a Region: 

1. Place the cursor in the Region Selection map. The Choose Region cursor appears on the map 
as a box. The box changes shape depending on its latitude on the map. 

2. Use the arrow keys to the scroll the map left/right until the desired map location is visible.  
3. Zoom the map by pressing [-] and [+] or [Ctrl] + left/right mouse click. Use the arrow keys to 

pan the map. 
4. Center the Choose Region cursor over the desired location of your new scenario. Right-click 

that region to select it as the mission area. 
5. You are prompted to confirm your region choice and to designate the type of mission to create: 

Single or Campaign mission.  
6. Click OK to accept the selected region and check-marked mission type or click CANCEL to 

return to the Region Selection Map and select a different location or mission type. 
Single Mission checked:  
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The chosen region is loaded and the Mission Creation screen appears. The mission created 
has a .mu extension. 
Campaign Mission checked:  
B The Campaign of New Mission dialog appears. This dialog allows you to assign the new 

mission you are creating to an existing named campaign (.cam file). (A campaign consists of 
two or more missions (.mc) files assigned to a .cam file.) If no Campaign file has been 
created, the mission is saved as a Single mission. You must first create a Campaign file 
before you can add Campaign missions to it. See Editor Menu/Campaign/Creating a 
Campaign on p. 19 

B To create a mission that is assigned to an existing named campaign, select the desired 
campaign filename then click OK. The mission you are creating is assigned a .mc extension 
and is assigned to the selected campaign. Click CANCEL to create a regular single mission. 
This mission file will have a .mu extension and will not be available to add to a .cam file. Only 
files created with a .mc extension can be added to a .cam file.  

LOADING PREVIOUSLY CREATED MISSIONS 
From the Mission Editor’s Region Selection interface you can also load and edit a single or 
campaign mission previously created by you or another user. 

To select an existing single mission scenario to edit: 

1. From the Editor Menu at the top of the screen select Mission>Load Mission. 
2. The Open File Dialog box appears. The Filename option is selected as default and the mission 

will be in alphabetical order by file name. Scroll to the desired scenario file name.  
3. Click the Title box and the missions will be listed alphabetically by the title set for the mission in 

Editor Menu’s Options>Set Mission Title dialog. If a title is not created, then the title defaults to 
the file name. 

4. In either mode, click the row containing the filename/title then click OK or double-click the 
filename or title to open that file in the Mission Editor. 

To select an existing campaign mission scenario to edit: 

1. In the Editor Menu at the top of the screen select Mission>Load Campaign Mission. 
2. The Load Campaign Dialog box appears. Select the desired campaign file name, then select 

the desired mission in the selected campaign and click OK. 

9 Note: To view or edit scenarios created by your friends, copy the desired scenario file into the 
Scenario directory in the directory where the game is installed. The scenario can then be selected 
from the Load Mission menu option. 

IMPORTING SCENARIOS 
You can import your favorite 688(I) Hunter/Killer, Jane’s Fleet Command, or Sub Command 
scenarios for use in S.C.S. - Dangerous Waters. The ship databases differ between these four 
games therefore some platforms in the imported scenarios may not be available in the current 
game. Imported scenarios will need varying degrees of editing to work properly in S.C.S. - 
Dangerous Waters.  

To Import a scenario: 

1. Copy the desired file into the S.C.S. - Dangerous Waters Scenario directory in the location 
where the game is installed. 

2. Select Mission>Import from the Editor Menu at the top of the screen. 
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3. The Open File Dialog box opens. Select the desired file to be imported and click OK or double-
click the file.  

4. When the file opens, look for red object labels (ships names, aircraft names, triggers etc) on 
the map. Red text indicates that the object needs to be remapped for S.C.S. - Dangerous 
Waters because the object is different or missing in the current databases. 

5. Select the icon of an object with a red label and change the object class and/or name in the 
Object Properties Panel to one that is available in S.C.S. - Dangerous Waters. Continue until 
all missing objects are remapped. Then save the mission using the Mission>Save menu option. 
For information on setting object properties See Mission Editor/Object Properties Panel on 
p.30. 

9 Note: The Object Names option must be turned ON in the Mission Map menu or the View 
menu in order for the Object labels to appear on the screen. Object names are ON by default. 

Mission Editor Tip: Delete the red text after you update the object described in that text. In some 
cases, for instance airports, where many planes may be missing, there may be several layers of 
text to delete. You may need to move the object icon to be able to select the text for deletion. 
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MISSION CREATION 
Selecting and loading a region on the Region Screen, or loading an existing mission, activates the 
Mission Creation screen. The region you selected in the Region Screen replaces the world map 
and all Editor Menu functionality is available. You can now tailor a mission that is as simple or as 
complicated as you desire. 

The Editor Menu options provide the means to add formations of ships, set alliances, add and 
define triggers, set environmental conditions, add dynamic groups, create scripts, and further 
customize your mission in a variety of ways. The remainder of this manual describes how to add 
and customize objects and explains the functionality of all Editor Menus.  

New objects are placed on the Mission Map using the object buttons along the lower right. Clicking 
on any object’s map icon allows you to edit its properties in the Object Properties Panel.  

The Scenario Browser appears over the Object Properties Panel when no object is selected on the 
Mission Map. The browser is very useful for tracking all objects, triggers, and groups in the 
scenario. You can also quickly view the Object Properties Panel pages for any object, trigger, or 
group by clicking on its Scenario Browser text. Press [Esc] or click the map to bring up the 
Scenario Browser. The Mission Creation screen of the Mission Editor is shown below with a 
regional map replacing the world map in the map area. 
Mission Map                                          Editor Menu

 
Description Bar       Object Properties Panel/Scenario Browser  

                                                                                                        Object Buttons 
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9 Note: You must place at least one controllable platform in your mission. Controllable 
submarine classes are the United States’ Seawolf and Improved Los Angeles (688(I)) classes, the 
Russian Akula-I Improved and Akula II classes and Russian and/or China’s Kilo 877 and Improved 
Kilo 636 classes. The United States’ surface ship, Oliver Hazard Perry FFG class is also 
controllable as is its MH-60R helicopter and the P-3C Orion Maritime Patrol aircraft. After you add 
one of these platforms, you must designate it as controllable on page two of its Object Properties 
Panel. See Object Buttons/Add Submarine or Ship on p. 14 and Object Properties 
Panel/Submarine Properties on p. 40 
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MISSION MAP 
The Mission Map contains the 600 by 600 nautical mile square region that was designated in the 
Mission Creation screen. It is on this map that you create the mission by placing all objects, 
assigning triggers, tactics, defining formations, and further customizing the scenario.  

9 Note: The words map and chart are used interchangeably in this section of the manual.  

MAP READOUTS 
The following readouts display in the lower left corner of the map: 

� Latitude and longitude. These values change with the cursor position.  
� The depth and elevation. Shows depth in feet when the cursor is over water and altitude in feet 

when the cursor is over land.  
� Ice Coverage. When the cursor is over the extreme northern and southern latitudes the amount 

of ice coverage in that area of the ocean is displayed as a percent just below the depth and 
elevation indicator. Ice itself is not visible on the map. The level of ice coverage changes 
depending on the time of year you set in the Editor Menu’s Setup>Environmental Conditions 
dialog box. 

� Range scale. Shown in nautical miles (nm) or yards depending on the level of zoom.  
B To determine the distance and bearing from a point on the map to another point, click the 

first point and drag the cursor to the second point. The bearing in degrees and the distance 
in nautical miles displays in lieu of the range scale in the lower left corner of the map. 
Release the mouse button to remove the range circle from the map. 

B Press [Shift]+[X] to toggle the display of the Longitude/Latitude, the Height/Depth and the Ice 
coverage readout. 

B Press [Shift] + [Z] to toggle the display of the range scale. 

9 Note: Use of the water depth readout information is important when placing submarines, since 
the water depth may be too shallow for them to operate. 

MAP CONTROLS: 
It is necessary to zoom in when placing objects that must be close together. 

B Press [+] to zoom in on the center of the map or [Ctrl] + left-click to zoom in on the location of 
the cursor.  

B Press [-] to zoom out on the center of the map or [Ctrl] + right-click to zoom out at the 
location of the cursor. 

B Use the arrow keys to pan the map. 

MISSION MAP MENU  
Right-clicking on the Mission Map brings up the Mission Map Menu. From here several map display 
options are available. A checkmark in front of any of the first four options indicates that the option is 
ON.  

Bathymetry: When ON, the Mission Map displays detailed colored shading indicating variations in 
water depth and land elevations. When OFF, the detailed shading is replaced by solid blue for 
water and solid yellow for land. (Defaults to ON.) 
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Scale: When ON, the range scale displays in the lower left corner of the Mission Map. (Defaults to 
ON.) 
Object Name: When ON, object names display on the Mission Map. Turning off this feature can 
help reduce clutter on the Mission Map. (Defaults to ON.) 
Tactics: When ON, all object tactics display as white lines on the Mission Map. Hiding the display 
of tactics helps reduce clutter when building a mission. (Defaults to ON.) 
Use Small Icons: When ON, small object icons display on the Mission Map. The use of smaller 
icons helps reduce the clutter. (Defaults to large icons.) 

Add Chart Text Label: When this option is selected the Map cursor changes to a + and you are 
prompted in the Description Bar to click the map to place a label. A text label appears on the 
clicked location as a small red square followed by the word Label and a sequentially higher number 
with each label placed. By default the square and the text are red. The text and the color can be 
changed. 
1. Click the small red square to bring up the Text Label properties panel on the right of the 

screen.  
2. Set the text content in the Label edit box. 
3. Select the desired color in the Text Color drop-down list.  
4. Click the map to initiate the changes. 
5. Click in the square to drag the label to a new location.  

Add Chart Lines: When this option is selected the Map cursor changes to a +. 
1. Click the map to place a line’s starting point.  
2. Click the desired point to draw the line to that location.  
3. Click an additional location to place a line to that point from the previous one.  
4. Press [Esc] to complete the process.  
5. To delete a line, click it to select it, and then press [Delete]. Each line segment must be deleted 

separately. A selected line is yellow instead of white. 

Add Chart Circle: When this option is selected the Map cursor changes to a +. 
1. Click the map to place the center of the circle. A white circle appears with default radius of 10 

nm, a white square at the center and the word circle in green and a sequentially higher number 
with each circle placed. (You must be zoomed in to see the circle.) 

2. Click on the white square to select it. The square turns red. 
3. The Map Circle’s properties panel appears. 
4. In the Circle Radius edit box enter the desired radius. Click the map to implement the change. 
5. In the Circle Color drop-down select the desired color of the circle. 

9 Note: Text labels, lines, and circles placed here appear on the map when the scenario is 
played.  
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OBJECT BUTTONS 
Use the Object Buttons on the bar located at the bottom right of the screen to place submarines, 
ships, global triggers, and land objects on the Mission Map and to create scripts. To customize an 
object you must select it and set specific properties in its Object Properties Panel pages at the right 
of the screen. See Object Properties Panel on p.30. 

B To display an object’s property panels click the object’s icon or select its name in the 
Scenario Browser. 

B To select a script to edit, select the Script’s name in the Scenario Browser on the Script 
page. A new script’s page appears immediately in the browser as soon as you click the 
Script button. Scripts do not have icons thus do not appear on the map. 

 
When creating a mission, you must create at least one controllable platform. Designate an 
appropriate platform as controllable on page two of a platform’s Object Properties Panel.  
Place other controllable platforms in the mission as desired and create individual tasking for each. 
The number of controllable platforms in a mission determines the number of players that can play 
that mission in Multiplayer mode. To make an eight-player multiplayer game, place eight 
controllable platforms in the mission.  

 

 
       Add Sub              Add Ship        Add Global Trigger   Add Building        Add Script 

 

Mission Creation Tip: Be aware of the great distances covered on the Mission Map when creating 
a mission. You can check how long it will take a ship to traverse a given distance by clicking on the 
waypoints of certain tactics. The Object Properties Panel to the right of the screen displays the 
amount of simulation time it takes the platform to reach that point. Though single player games 
have the option of time compression, multiplayer scenarios cannot use accelerated play. Zoom in 
when placing objects to ensure the desired distance between objects. 

ADD SUBMARINE OR SHIP BUTTON 
1. Click the SUBMARINE or SHIP buttons to add an object of that type. 
2. Move the cursor to the map and click to place the object. Customize the object using the 

property options available in the Object Properties Panel to the right of the map.  
� To learn more about the properties available for ships or submarines, see Object Properties 

Panel/ Ship Properties on p. 38 or Submarine Properties, on p. 40. 

ADD GLOBAL TRIGGER BUTTON 
1. Click the TRIGGER object button then click the map top place the trigger icon.  
2. Click the trigger icon to select it and display its Object Properties Panel pages.  
� For more details see Mission Editor/Triggers/Global Trigger Object Properties Panel Pages on 

p. 44. To set the order in which certain triggers must be accomplished, see Mission 
Editor/Triggers/Trigger Precedence on p. 52. 
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ADD LAND-BASED/BUILDING OBJECT BUTTON 
Click the BUILDING object button. 

1. Move the cursor within the Mission Map and click to place the land object. Click the building 
object icon to display its Object Properties Panel pages. 

� For details on assigning properties to land-based objects, see Object Properties Panel/Land-
Based/Building Properties on p. 34. 

Mission Creation Tip: Use of the land altitude readout information is important when placing 
buildings, since the buildings need to be placed on land. You may want to make use of the terrain 
features when positioning your building. Zoom in as much as possible when placing land objects. 

9 Note: Most of the objects available for placement via this button are indeed land-based; 
however, there are several notable exceptions. The Oil-Rig, Downed Satellite, Naval Base, and 
Docks are also available here and can be placed in the water. 

ADD SCRIPT BUTTON 
Click the SCRIPT button to open the Script Property Panels. Scripts do not have an icon on the 
map. Edit scripts by selecting the script name on the script page in the Scenario Browser 

B Press [Esc] or click the map to bring up the Scenario Browser. Click the Script tab. Click the 
name or number of the desired script to edit it.  

B To delete a script, select the script name in the Scenario Browser’s Script tab. Then press. 
[Del]. 

For information on creating scripts see Mission Editor/Scripts on p.54.  
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MISSION OBJECT MENU 
Right-click on a mission object’s icon to enable the Mission Object Menu. Some of the features 
found in the Mission Object menu are also available from the Object Properties Panel pages for the 
selected object. 

The Mission Object menu provides a shortcut to add or delete platforms from formations, and 
assign attached triggers to the selected object. 

Mission Object menu items that are not available for a specific object are grayed out and 
disabled. For example, since a submarine does not have embarked aircraft, all options relating to 
aircraft are unavailable. 

� The Add Inflight Aircraft and Add Air Station options are only available for ships with 
embarked aircraft and land-based airport objects once aircraft have been added to the airport.  

� The Add Air Corridor menu item only applies to land-based airports.  
� The Flight Schedule menu item is only available on the Mission Object menu. Use the Flight 

Schedule menu item to assign alert readiness conditions to aircraft embarked on a ship or for 
aircraft located at an airport.  

� The View Sensor Ranges menu item is only available on a Mission Object that has sensors. 
Use the View Sensor Ranges menu item to graphically depict nominal sensor coverage 
against another selected platform. 

ADD TO FORMATION 
Mission Object menu’s Add to Formation item is only available (not greyed out) if there is a 
formation in the mission you are creating. To add a platform to an existing formation, this menu 
option is the quickest method. 

To add an object to a formation:  

1. Right-click the platform object to display the Mission Object menu.  
2. Select Add to Formation. A menu appears displaying the names of formations to which you 

can add the object. Once the object is added to the formation, a blue line links this object to the 
formation leader on the Mission Map.  

For details on how to create a formation see Editor Menu/Options Menu/Formations, on p. 26.  

9 Note: Once you add the platform to a formation, any tactics you may have previously assigned 
to this platform are lost. Platforms in formation follow the formation leader and its assigned tactic. 

UNLINK FROM FORMATION 
Use the Unlink from Formation option in the Mission Object menu to remove a platform object 
from a formation.  

To unlink an object from a formation:  

1. Right-click the icon to access the Mission Object menu.  
2. Select Unlink From Formation. The blue link line attaching the object to the formation leader 

disappears. 
3. On page one of the selected object’s Object Properties Panel, assign a new tactic to the object.  
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ADD ATTACHED TRIGGER 
Triggers can be attached to specific objects in a mission.  

To add an attached trigger:  

1. Right-click the object’s icon to activate the Mission Object menu. 
2. Select Add Attached Trigger. You are prompted in the Description Bar to click the Mission 

Map to position the attached trigger. A blue link line between the attached trigger and the 
object is established.  

3. Click the trigger icon to select it and display its Object Properties Panel pages. 
� For a detailed discussion on the types of attached triggers and how to customize attached 

triggers, see Triggers/Attached Triggers on p.49. 

ADD INFLIGHT AIRCRAFT 
The Add Inflight Aircraft menu option is only available (not greyed out) if the object you have 
selected has embarked aircraft or is a land-based airport with aircraft already assigned. For 
information on assigning aircraft to an airport see Mission Editor/Object Properties Panel/Airport 
Properties on p. 32.)  

To add an inflight aircraft:  

1. Right-click the aircraft’s base object icon (ship or airport) to display the Mission Object menu.  
2. Select Add Inflight Aircraft. In the Description Bar below the Mission Map you are prompted 

to left-click the map to position the inflight aircraft. The inflight aircraft icon is placed on the 
Mission Map and a blue link line appears between the aircraft and its base.  

3. Click the inflight aircraft icon to select it. The Object Properties Panel has a Name field with a 
selection of available aircraft to use for this station. The Object Properties Panel also has fields 
allowing you to specify the speed, altitude, tactic and assign the weapons loadout for the 
aircraft. For additional details on inflight aircraft, see Object Properties Panel, Inflight Aircraft 
Properties p.36.  

ADD AIR STATION 
The Add Air Station menu item from the Mission Object menu is only available (not greyed out) to 
ships with embarked aircraft or an airport after aircraft have been added. The primary difference 
between adding an inflight aircraft and an air station is that the inflight aircraft option allows a single 
aircraft to be placed while the air station can be assigned up to two aircraft.  

To add an air station:  

1. Select the object that has aircraft assigned (ship or airport) and right-click the selected icon to 
display the Mission Object menu. Select Add Air Station.  

2. Click the Mission Map to place the air station. 
3. Click the air station icon to select it. Options for this air station appear in the Object Properties 

Panel. The panel has two fields that allow you to specify what aircraft you want assigned to this 
station.  

� For complete instructions on setting air station properties see Mission Editor/Object Properties 
Panels/Air Station Properties on p. 31 

ADD AIR CORRIDOR (AIRPORT) 
The Mission Object menu’s Add Air Corridor menu is only available (not greyed out) for land-
based airport objects. This feature allows you to add an air corridor attached to an airport. This 

  Page   17



 

option is different from the Editor menu’s Add>Add Air Corridor option which adds independent 
flight paths that traverse the mission area. The Add Air Corridor feature is also available on the 
third page of the Object Properties Panel options for an airport. 

To add an air corridor:  
1. Right-click an airport’s object icon to activate the Mission Object menu and select Add Air 

Corridor. The Add Air Corridor menu item is only available after aircraft have been added to 
the airport. 

2. Click in the direction that you want the corridor to run. One end of the air corridor is anchored 
to the airport and the other end automatically extends to the edge of the Mission Map in the 
direction you click.  

3. To select an air corridor that is attached to an airport, you must click the large white rectangles 
appearing at the edge the corridor’s path at the edge of the map. You may have to zoom the 
map all the way out until the entire region is visible before you can access the corridor’s 
selection point. When the corridor is selected the white lines turn red. For details on 
customizing an air corridor, see Object Properties Panel/Air Corridor Properties, on p.30.  

FLIGHT SCHEDULE 
In S.C.S. - Dangerous Waters you can set the state of readiness for enemy and allied aircraft 
embarked on ships and at airports. Aircraft are controlled by the AI but what you set here 
determines how quickly ASW planes and helicopters respond to submarines detected by AI 
controlled ships. The default readiness state for all aircraft is thirty minutes. You have the option to 
schedule some aircraft in either an Alert 5 condition (aircraft is available to launch in five minutes), 
Alert 15 (aircraft is available to launch in fifteen minutes), or Alert 30 (aircraft is available to launch 
in thirty minutes). For some ships with embarked aircraft there is only one runway or landing pad 
available. Therefore only one aircraft is allowed to be in an Alert 5 readiness state. Aircraft carriers 
have multiple airstrips from which to launch aircraft so they permit more than one aircraft to be in 
Alert 5 condition. You are not able to place more than the allowed number of aircraft in an Alert 5 
condition. You may place up to 24 aircraft in Alert 15 and Alert 30 condition.  

To access the Flight Schedule:  
1. Right-click the object icon for an airport or ship with embarked aircraft to display the Mission 

Object menu.  
2. Select Flight Schedule to display the Flight Schedule dialog box.  
3. Select the radio buttons for the desired alert condition (5, 15, or 30) for each individual aircraft.  
4. Change the Flight Schedule for other aircraft types by selecting them in the list box at the top of 

the Flight Schedule box.  

9 Note: The Flight Schedule menu item is only available if a ship or airport has aircraft assigned 
to it. 
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EDITOR MENU 
The menu bar at the top of the Mission Creation screen contains tools for, saving, editing, and 
customizing your mission. The Editor menu consists of the following menu items: Mission, 
Campaign, Edit, Setup, View, Add, and Options.  

 

MISSION MENU 
New Mission: Create a new mission by selecting a new region. You are prompted to save the 
current mission then returned to the Region Selection Screen. 
Load Mission: Load a previously created mission. 
Load Campaign Mission: Loads a previously created campaign mission. 
Save Mission: Save your current mission. If your current mission is a new mission and has not yet 
been saved, you are prompted for a file name. 
Save Mission As: Specify a new name for your current mission and save it.  
Set File Password: Selecting this option displays the Password for Scenario File dialog box. Type 
the desired password in the Password and Password Verification fields and click OK. The file 
cannot be loaded unless the password is supplied.  
Recent Files: Displays the five most recently opened files.  
Exit: Exit to the game’s Main Menu screen.  

CAMPAIGN MENU 
This menu provides a means to create a campaign (.cam) file, add existing campaign mission (.cm) 
filenames to a campaign file, order missions as desired within the campaign. Individual campaign 
missions must be opened and edited separately using the Mission>Load Campaign Mission option. 
You must designate a new mission as a campaign mission when you create it.  
New: Use this option to create a new Campaign. Selecting this option displays the Edit Campaign 
dialog box. Use this dialog to create a new .cam file. 
B In the Campaign Name edit box, type the desired name for the new campaign then click OK. 

A new campaign has now been created and is available to receive individual campaign 
missions. Campaign missions are created using the Editor menu’s Mission>New option, and 
then selecting Campaign Mission in the New Mission dialog. 

Edit: Selecting this option displays the Edit Campaign dialog box. Select the campaign to be edited 
from the campaign file names listed then click OK. The Edit Campaign dialog box opens with the 
selected campaign name selected and all missions in the Campaign listed in Mission Window. 
From here you can add, rename, delete or reorder the missions in the selected Campaign. 

Add: Selecting this options brings up a Campaign Mission dialog box that allows you to select 
a campaign mission to add to the selected campaign file. Single mission files are not visible 
here. Only missions created as Campaign Mission files via the Mission>New option (or the 
Region Selector) appear in the Browser list. 

9 Note: The Brief is a placeholder for a later upgrade. Type any file name with a .grp file 
extension, e.g., xx.grp. 
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In this interface filenames are limited to 18 characters including the required .mc extension. 
These names can be edited by hand in the scenario file if a longer name is desired. 
Edit: Select a campaign mission then use this option to edit the mission file name. 
Remove: Use this option to remove the selected mission from the campaign. 
Mission Order: Use these arrow buttons to rearrange the campaign missions to reflect the 
order in which they are to be played. 

EDIT MENU 
Undo: Your last change (Add Object, Move Object, Delete, etc.) is listed after the word undo. 
Select this option to undo the change listed. You can undo all changes you have made since you 
last saved the mission by selecting this option repeatedly. The most recent change is undone until 
the first change is reached. 
Redo: Select this option to redo the change listed after the word Redo. Repeated selection of this 
option returns to the map changes that were previously removed by using the Undo feature.  
Copy: Copy a hooked object on the Mission Map. (You may also press [Ctrl] + [C].) 
Paste: Paste a copied object anywhere on the map. (You may also press [Ctrl]+[V] and click the 
map to paste the object.) 
Delete: Delete a selected object. (You may also press [Delete].) 
Select Multiple Objects: Allows you to click and drag over the map to select more than one object 
to edit. As you drag the mouse, a box appears showing the selection area. Any objects appearing 
in this area are selected. Release the mouse button to complete selection of the objects. (Map 
labels, map circles, and lines are not objects and cannot be selected with this tool. They must be 
selected and moved or deleted individually.) 
Set Random Start Box: Allows you to set a Random Start Box around a selected object. When 
this option is selected, a white box appears on the map with the selected object at the center. This 
box moves and sizes as you move the mouse. Click the left mouse button to set the box size. The 
centered object begins the mission at a random point within this box. Once set, a Random Start 
Box displays with green lines. Tactic boxes have white lines. 
Remove Random Start Box: Deletes the Random Start Box assigned to the selected object. 

SETUP MENU 
Define Mission Description: Create or edit a description of the mission. This is the brief 
description of the mission that appears on the Mission Selection screen. 
Set Mission Title: Create or edit a name for the mission and define its level of difficulty. Level of 
Difficulty is represented by the number of stars that appear on the Mission Selection screen in front 
of the mission title. One star indicates an easy mission. The default setting is one star. If no mission 
name is specified, the title is the mission’s file name by default.  

9 Note: The mission title text field is limited to twenty characters.  

Side Alliances: Selecting this option displays the Alliance Manager Dialog. From here you select 
the sides to be allied. Setting up side alliances is useful in scenarios that require two countries 
working in cooperation. Assume you want to have the U.S. (Side 0) and Taiwan (Side1) working 
together in a mission. In the Alliance Dialog set side 0 (U.S.) to be allied with Side 1 (Taiwan). If 
during gameplay you opt to Show Allies you see the actual position and type of the Taiwanese 
platforms as orange symbols on the Nav Map. In the described instance, AI controls the Taiwanese 
platforms but they do not attack your platforms. You can also set two AI controlled sides to be 
allies. They do not attack each other. They only attack sides not in their alliance. 

Alliance Name: Existing named alliances display in this drop-down list. To add a named 
alliance, click ADD ALLIANCE. 
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Add Alliance: Clicking on this button brings up the Alliance Name dialog box. Type the desired 
name in the dialog box.  
Delete Alliance: Deletes the Alliance selected in the Alliance Name drop-down list. 
Sides In Alliance: Displays the sided in the Alliance selected in the Alliance Name drop-down 
list. 
Available Sides: List all sides possible, even those that have not been assigned any 
platforms. 

To Create an Alliance: 

1. In the Alliance Manager Dialog box click ADD ALLIANCE. The Add Alliance dialog box 
appears. 

2. In the Add Alliance dialog box, type a name for your alliance in the Alliance Name edit box. 
Click OK to return to the Alliance Manager Dialog box. 

3. In the Alliance Name drop-down list, select the name of the alliance you just created. 
4. In the Available Sides list select the name of a side you want to place in the alliance then click 

the left-facing arrow (½) arrow to place that side in the Sides in Alliance list (left box). Add sides 
from the “Available Sides” list until the “Sides in Alliance” list contains the desired members. 

5. Select a name in the “Sides in Alliance” list on the left and click the right-facing arrow (¾) to 
return remove a side from the selected alliance. 

6. Click OK. 
Rules of Engagement: Selecting this option displays the Rules of Engagement (ROE) dialog box. 
Wartime Rules of Engagement selected by default. 
1. Select a side in the “Sides Available” list.  
2. Click one of the following options to assign the Rules of Engagement for all platforms on that 

side. 
War Time: Platforms fire upon all threat platforms  
Peace Time: Platforms do not fire unless fired upon. 

Ownship Must Survive: This option is used primarily in the creation of campaign missions. When 
this option is selected, that the player’s controllable platform must survive the mission in order to 
satisfactorily complete the mission. This is requirement regardless of the resolution of any of the 
mission triggers. For example, assume the critical trigger in a mission is to sink a cargo ship. 
During mission play, the player’s controllable platform is sunk. However, later in the mission, a 
platform allied with the player sinks the cargo ship. If the Ownship Must Survive option had been 
selected, the resolution of the mission would be incomplete even though the critical trigger had 
been accomplished. This option defaults to on. 
Environmental Conditions: Allows you to set the environmental conditions for your mission. 
Selecting this option displays the Conditions dialog box. Options are described below: 

Sea State: Set the condition of the sea, from 1 (calm) to 5 (very rough).  
Time of Day: Set the time of day at which the mission begins using 24-hour military time. 

9 Note: When you make a change to the time of day, a confirm box appears with 
this notice: “Changing Time of Day will affect all triggers. Do you want the times to be 
automatically updated to reflect the new start time?” If you select the YES button, all times 
for your triggers are adjusted to maintain the same time interval relative to the original 
mission start time. 

Bottom Type: Set the state of the sea floor: rock, mud, or sand. These conditions affect sound 
propagation for active and passive sonar operations. 
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Month: Set the month in which the mission takes place. The time of year designated 
determines the level of ice coverage in the northern and southern latitudes and the amount of 
daylight in a mission. 
Weather: Set the weather conditions in which the mission takes place. Available selections are 
Clear, Puffy Clouds, Overcast and Rain. These weather conditions can affect sensor detection 
ranges and visual ranges. 
SSP Type: (Sound Speed Profile). These SSP types determine the sound propagation paths 
available for acoustic sound energy to travel and the depth of any thermal layer.  

Surface Duct: When selected a thermal layer is created at a random depth between 400 
and 1200 feet. If the depth of the ocean in the mission area is less than 400 feet, no layer 
will be created. 

Bottom Limited: When selected no thermal layer is created. While this condition is 
normally associated with shallow depths no layer will be created even if the mission area is 
located in an area of deep water. 

Convergence Zone: When selected a layer is created at a random depth between 300 
and 500 feet. Contacts may be detected at a long range then lost and picked up again at a 
much closer range. If the ocean bottom in the selected mission area is less than 300 feet, 
no layer is created. 

Cloud Height: Set the height of cloud cover. 
Add Wind Conditions: Select this option then click and drag on the map to define the region. 
Make sure to click and drag before letting go otherwise the wind region is a dot on the map and not 
a real region. During mission play, a wind region will have the affect of objects drifting with the 
wind. For example, a strong wind will have a substantial affect on the flight of a launched flare. The 
wind will also affect the course made good for ships and aircraft. When launching a helo from a 
controllable O.H. Perry class frigate, the player must ensure that the wind is within the launch 
envelope. Options in the wind dialog box are described below. 

Region Name: Set the name for this wind region. 
Wind Speed: Set the sustained wind speed. 
Wind Gust Speed: Set the wind speed that the wind will randomly gust up to. 
Wind Direction: Set the direction that the wind is coming from (000-360). 
Min Altitude: Set the lower elevation of the wind layer. 
Max altitude: Set the upper elevation of the wind layer. If this value is left at 0, then this 
wind region will have no effect. 

View all Wind Regions: When selected (check-marked) all defined wind regions appear on the 
map. 
Remove Wind Regions: Displays a list of named wind regions. Select the region name to be 
removed. 
Add Water Region: Make sure to click and drag before letting go otherwise the water region is a 
dot on the map and not a real region. During mission play, a water region defines the direction and 
speed of the water currents. Objects in the water will drift based on the parameters of the water 
region as defined below. 

Region Name: Set the name for this water region. 
Water Current Speed: Set the current speed of the current. 
Water Direction: Set the direction towards which the water is traveling (000-360). 
Min Depth: Set the shallow depth of the water region layer. 
Max Depth: Set the deeper depth of the water region layer. If this value is left at 0, then 
this water region will have no impact. 
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View All Water Regions: When selected (check-marked) all defined wind regions appear on the 
Mission Map.  
Remove Water Region: Displays a list of named water regions. Select region name to be 
removed. 

VIEW MENU 
Bathymetry: Toggle the display of sea/land contour shading ON/OFF. A check mark indicates this 
feature is ON. (Defaults to ON.) 
Scale: Toggle the map scale indicator ON/OFF. A check mark indicates this feature is ON. 
(Defaults to ON.) 
Gridlines: Toggle the display of gridlines on the map. (Defaults to OFF.) 
Object Names: Toggle the display of names adjacent to objects ON/OFF. A check mark indicates 
this feature is ON. (Defaults to ON.) 
Tactics: Toggle the display of all assigned tactics and waypoints ON/OFF. A check mark indicates 
this feature is ON. (Defaults to ON.) 
Type: Toggle ON/OFF the display of the various types of platforms and objects: surface ships, 
aircraft, submarines, land-based objects, mines, and triggers. A check mark indicates that the icons 
for a specific type are displayed on the Mission Map. (All types default to ON.)  
Side: Choose which sides’ forces are shown on the map. A check mark indicates that icons for the 
specified side are displayed on the Mission Map. (All sides default to ON.) 
Group: Toggle the display of all platforms in a dynamic group ON/OFF. A check mark indicates 
that the platforms in the group are displayed on the Mission Map. (Each group defaults to ON.) 
Filters: Allows you to choose several view filters at once, including viewing by side, platform type, 
and dynamic groups. A check mark indicates that the particular side, type, or group is ON and is 
displayed on the Mission Map. (All are ON.) 
View Full Screen 3D: Selecting this option displays in full screen the 3D object in use for the 
selected platform or building. 
B Click the 3D window and drag the mouse to rotate the angle of your view 
B Press [Ctrl}+ left-click and drag to zoom in and out. 
B Press [Shift] + left-click and drag left or right to pan. 
B Press [Ctrl] + arrow keys to rotate around the object. 
B Press [Esc] to return to the Mission Editor interface. 

Tip: Check the 3D view for airports and buildings. If the building appears to be buried, adjust the 
placement of the building Icon. 

ADD MENU 
Transiting Waypoints: Assign a set of moveable waypoints for a platform to transit before 
beginning a specified tactic. 

9 Note: The Transiting Waypoint menu item is only available when you select a platform that has 
been assigned a name and a tactic. The platform starts the mission at the outermost waypoint and 
transits each waypoint until it reaches the location of the platform icon. The platform then executes 
its assigned tactic. 

Waypoint: Add an additional waypoint to the platform’s path for tactics that already contain 
waypoints. 
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9 Note: When you add a waypoint to a tactic you must have one of the waypoints in the tactic or 
the object icon itself selected to activate the menu item. 

Minefield: Place a minefield on the map. Mines must be placed in water.  

To add a minefield to your mission: 
1. Select Minefield from the Editor menu’s Add menu 
2. You are prompted in the Description Bar to click and drag on the Mission Map to define the 

area for the minefield.  
3. When you have defined the area on the map, release the mouse button. You have defined the 

area in which the mines are evenly distributed. The Minefield Designation dialog box appears. 
The Minefield Designation dialog box fields are described below. 

Mines Across: Enter the number of mine columns. 
Mines Down: Enter the number of mine rows. 

9 Note: The total number of mines permitted in the minefield is limited to one hundred. Check 
the total number of mines by multiplying the number of rows by the number of columns. 

Mine Type: Select the mine type from the drop-down list, either a Moored Contact or Moored 
Influence Mine. A contact mine detonates only when an object makes physical contact. An 
influence mine detonates when a ship or submarine disturbs the area around the mine. (A 
Moored mine anchored with a mooring cable.) 
Depth (ft): Enter the depth for the minefield in feet in this field. If you enter a mine depth that 
exceeds the water depth, a message box appears when the mission is saved notifying you that 
the object exceeds the water depth. 
Side: Select the side this minefield belongs to. 

9 Note: Use of the water depth readout information is important when placing mines since the 
water depth may be too shallow for them to operate. 

Sonobuoy Field: Place a sonobuoy field on the map. Sonobuoys must be placed in the water.  
To add a sonobuoy field to your mission: 
1. Select Sonobuoy Field from the Editor menu’s Add menu 
2. You are prompted in the Description Bar to click and drag on the Mission Map to define the 

area for the Sonobuoy field.  
3. When you have defined the area on the map, release the mouse button. You have defined the 

area in which the sonobuoys are evenly distributed. The Sonobuoy Field Designation dialog 
box appears. 

The Sonobuoy Field Designation dialog box fields are described below. 
Buoys Across: Enter the number of buoy columns. 
Buoys Down: Enter the number of buoy rows. 

9 Note: The total number of buoys permitted in the buoy field is limited to one hundred. Check 
the total number of buoys by multiplying the number of rows by the number of columns. 

Buoys Type: Select the buoy type from the drop-down list. 
Side: Select the side this buoy field belongs to. 

Add Corridor: An Air Corridor is a flight path aircraft take during the mission. You can change air 
corridor options such as the type of aircraft and rate of generation, see Object Properties Panel/Air 
Corridor Properties, on p.30. 
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StandAlone Aircraft: Selecting this option allows a player to insert an inflight aircraft into the 
scenario that is not associated with an airport nor aircraft capable ship. An Add Aircraft dialog box 
will appear allowing you to select the country, class, and name of the aircraft you want to insert, 
see Object Properties Panel/Inflight Aircraft Properties, on p.36.  
Environmental Object: Selecting this option allows you to insert a whale, school of shrimp, or an 
iceberg into the scenario, see Object Properties Panel/Environmental Properties, on p.34. 
Dynamic Location: This option let you specify a location where a selected mission object or group 
of mission objects will be randomly placed at start mission. If you have entered three Dynamic 
Locations and designate three objects for dynamic placement, each object will be randomly 
assigned to one of the three locations when the mission loads. If more than three objects are 
designated, multiple objects will be assigned to some dynamic locations. See Object Properties 
Panel/Dynamic Location Properties, on p. 33. 
Select Dynamic location then click the map.  
Click ADD in the Object Properties Panel. A list of al object currently added in the mission appears. 
Select an object to add to a dynamic location. 
Chart Text Label: When this option is selected the Map Cursor changes to a + and you are 
prompted in the Description Bar to click the map to place a label. A text label appears on the 
clicked location as a small red square followed by the word Label and a sequentially higher number 
with each label placed. By default the square and the text are red. The text and the color can be 
changed. 
1. Click the small square to bring up the Text Label properties panel on the right of the screen.  
2. Set the text content in the Label edit box. 
3. Select the desired color in the Text Color drop-down. 
4. Click in the square to drag the label to a new location. 

9 Note: Text labels placed here appear as map text when the scenario is played. 

Chart Lines: When this option is selected the Map Cursor changes to a + and you are prompted in 
the Description Bar to click the map to add lines.  
1. Click the map to place a line’s starting point.  
2. Click the desired point to draw the line to that location.  
3. Click additional point to place a line to that point from the previous one.  
4. Press [Esc] to complete the process.  
5. To delete a line, click it to select it and press [Delete]. Each line must be deleted separately. A 

selected line is yellow. 

Chart Circle: When this option is selected the Map cursor changes to a +. 
1. Click the map to place the center of the circle. A white circle appears with default radius of 10 

nm, a white square at the center and the word circle in green and a sequentially higher number 
with each circle placed. (You must be zoomed in to see the circle.) 

2. Click on the white square to select it. The square turns red. 
3. The Map Circle’s properties panel appears. 
4. In the Circle Radius edit box enter the desired radius. Click the map to implement the change. 
5. In the Circle Color drop-down select the desired color of the circle. 
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OPTIONS MENU 
Create Dynamic Group: Create a grouping of objects and assign a probability of inclusion for the 
group as well as specific members of that group. A group can contain any combination of ships, 
planes, subs, or land-based objects. See Mission Editor/Dynamic Groups/Create Dynamic Group, 
on p. 61. 
Edit Dynamic Group: Modify dynamic group properties. You can change the composition of a 
dynamic group, adjust the probability that group will appear, and change the minimum and 
maximum range for the number of objects that will be created from the group. See Mission 
Editor/Dynamic Groups/Edit Dynamic Group on p. 62. 
Trigger Precedence: Set a tree structure for a group of triggers to specify which predecessor 
triggers must be completed before other triggers can be completed. For detailed information see 
Mission Editor/Triggers/Trigger Precedence, on p. 52. 
Formations: Choose a formation and type of group, or customize a formation. Formations are 
composed of multiple ships. To place a formation, follow the steps for placing a single ship. See 
Mission Editor/Object Buttons/Sub or Ship on p.14. The formation options are described below. 
Create Formation: Allows for the creation of a custom formation. 
To create a custom formation: 
1. Place all objects to be included in the formation using the Object Buttons. Select all the objects 

by using the Edit>Select Multiple Objects option then dragging a box around the platforms you 
wish to select or press [Shift] while clicking on multiple objects. 

2. From the Formations menu select Create Formation. The Formations dialog box appears. 
Enter a name in the Formation Name field. Select the formation leader from the list of selected 
objects. The objects added to this formation follow the speed and movement of the leader. 
Ships in a formation are connected on the map by blue lines. 

3. To add a single object to the formation, place the object icon on the map, then right-click it. 
From the Mission Object menu select Add to Formation. A list of available formations appears. 
Choose the formation to which you would like to add the platform. 

Delete Formation: All formations are listed when this option is selected. In the list select the name 
of the formation you want to delete. The lines between ships in the formation are removed. You 
must now assigned a tactic to the ships. 
Standard Formation: Allows for the placement of one of several standard battlegroup formations 
on the Mission Map. Select the type of battle group you wish to place on the map. Right-click the 
map to place the group.  

SAG Place a Surface Action Group as your formation.  
ARG Place an Amphibious Ready Group as your formation. 
CVBG Place a Carrier Battle Group as your formation. 

9 Note: When you place a fleet on the map, it defaults to a United States battlegroup. To 
change the fleet’s nationality, you must click each individual ship and assign it a new 
nationality, class and name using the Object Properties Panel at the right of the map. 

Formation Tactics: 
The tactics available for the leader of a formation are different from those of a single ship. To view 
the tactics available to a formation leader, select the formation leader and view the options listed in 
the Tactics drop down list in the Object Properties Panel. 

PIM Waypoints: Drag a line across the map and release. The formation leader travels through 
the waypoints and continues in a straight line upon reaching the final waypoint. 
PIM Area Waypoints: Drag a square across the map and release. The formation leader 
travels to each waypoint and begins again when the last waypoint is reached. 
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SCENARIO BROWSER 
The Scenario Browser is a useful tool for locating a specific platform, trigger, or group in a scenario 
you are creating or editing. It is also valuable for reviewing and filtering objects in a large or 
complicated scenario. 
The Scenario Browser displays over the Object Properties Panel when no object is selected. It 
contains a directory tree of “folders”. The top folder on every tab contains the scenario filename 
once the scenario is saved. Until the scenario is saved the default text Unnamed Scenario appears. 

 

USING THE SCENARIO BROWSER 
By default the Type Tab is selected. The names of objects are contained in folders on each tab.  
B Click the – in front of a folder to hide the names of all object names in that folder. 
B Click the + in front of a folder to open the folder and display the names of the objects 

contained in the folder without selecting anything in the folder. 
B Click a folder name to select the folder. 
B Click an object name to select that object on the Mission Map. 

� If the object’s Type, Group, or Side is not hidden using the View filters the object’s icon is 
highlighted on the map. Depending on your level of zoom, you may need to scroll or zoom in or 
out to see the highlighted icon.  

� Selecting a specific object name on any tab page displays its Object Properties Panel pages. 
You are returned to the page you were on the last time that object was selected. 

� Use selections in combination to further filter what is on the map. For instance, select Side 2 on 
the Side tab and Surface on the Type tab to see only Side 2 surface ship icons on the map. 
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To return all object icons to the map: 
B Click the filename text at the top of all pages to turn off all filters. Clicking on the filename on 

any tab deselects all options on that tab and turns off that specific filter.  
or 
B From the Editor menu select View>Filters and place a check in front of all unchecked 

selections, then click OK.  

9 Note: If you have selected the filename at the top of the browser page and the icon you want 
to see on the map is still not visible, the object’s icon is being hidden by a filter on a different tab.  

To display the Scenario Browser when it is hidden, press [Esc] or click the map to deselect any 
selected objects. The browser is displayed when no object is selected on the map. The Scenario 
Browser’s six tabs are described below.  

ALL TAB 
By default the All tab is visible when the mission is opened. As you add objects to the scenario all 
object names are listed on the All page in the order in which they are entered.  
B Click the name of any object to display the object’s Properties Panel pages and select its 

icon on the Mission Map. 

GROUP TAB 
When dynamic groups are present in a scenario they are listed by name on the Group tab. The 
members of each group are listed in a group folder. For information about creating Dynamic 
Groups see Mission Editor/Dynamic Groups on p. 59. 
B Click a group name to display that group’s icons on the Mission Map. When a group name is 

selected, its text is blue.  
B Click the + in front of the folder to open it without selecting the group name. 
B Clicking on a group name hides the icons of any other groups on the Mission Map. Only the 

icons of the selected group members and those of objects that are not part of any dynamic 
group are visible. 

To redisplay all groups on the map: 
B Click the scenario filename at the very top of the browser’s Group tab to redisplay all groups 

on the map. 
To redisplay a specific group on the map: 
B Select View>Group then the desired unchecked group name. 
B Or select View>Filters then ensure that there is a check mark in front of the name of the 

dynamic group you want displayed. 

TRIGGERS TAB  
B Click a trigger name on the Triggers tab to select that trigger’s icon on the map and brings up 

its Properties Panel pages. 
� If the map is zoomed in, you may not be able to see the selected Icon. Zoom out to determine 

its location. 
� Trigger icons that are attached to objects on a specific side, type, or group are hidden on the 

map if that side, type or group is hidden. The trigger’s Properties Panel pages appear when the 
trigger name is selected even if you cannot see the icon on the map. 
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SIDE TAB 
The Side tab allows you to view only the objects assigned to a specific side. Objects from all other 
sides are hidden.  
B Click a side name to select that side and hide the object icons associated with all other sides 

on the map. 
B Click the + in front of a side name to display the names of all objects on that side without 

selecting that side name.  
B Click the text of the scenario filename at the top of the Side browser page to redisplay all 

sides in the scenario in the map. 

TYPE TAB 
Selecting the name of an object type on the Type tab displays only objects of that type on the map 
and hides the icons of all other types. Object types are surface, submarines, air, land-based 
(buildings), mines, and triggers. 
B Click the + in front of a type name to display the names of all objects of that type without 

selecting that type name.  
B Click a type name to select that type of object and hide the object icons of all other types on 

the map. 
B Click the text of the scenario filename at the top of the Type browser page to redisplay all 

types of objects in the scenario on the map. 

SCRIPT TAB 
Selecting a Script name from the list displays the Script property panel for the selected script item. 
There is no map icon associated with a script object so nothing is selected on the Mission Map. 
B To delete a script, select it from the Script tab. Move your mouse into the Mission Map, then 

press [Delete]. You are prompted to affirm that you want to delete the object.  
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OBJECT PROPERTIES PANEL 
Every object has properties that can be set in its Object Properties Panel.  
Finding the desired Object Properties Panel: To see a specific object’s Object Properties Panel 
pages, Click the desired object’s icon, or select the name of the desired object in the Scenario 
Browser. Scripts can only be selected from the Script tab in the Scenario Browser. 
B Click the map or press [Esc] to bring up the Scenario Browser.  

Navigating the pages: The current page number and the available number of pages is shown at 
the bottom of the Object Properties Panel  
B Click the right-facing double arrows at the bottom of the panel to move to the next page. 
B Click the left-facing double arrows at the bottom of the panel to move back a page. 
B If click off an object, then click it again, you return to the page you were on when you last 

viewed the object. 
Viewing 3D Models: The last page in the Object Properties Panels for a platform or building object 
displays the 3D model in use for that object. For platforms, a Country, Class, and Name must be 
selected on page one before any 3D model can be displayed on the 3D model page. Buildings 
must be assigned a specific name before a 3D model can appear.  
When a 3D model is present on the last page of the Object Properties Panel it can be manipulated 
as described below. 
B Click the 3D model and drag the mouse to rotate the angle of your view 
B Press [Ctrl] and drag forward and back to zoom in and out. (You can also use the mouse 

wheel or press [Ctrl] + [=] or [-] to zoom in and out.) 
B Press [Ctrl] and click and drag left or right to pan. 
B Press [Ctrl] + arrow keys to rotate around the object. 

Tip: It is especially helpful when placing land objects in a mission to check the object’s location and 
orientation in 3D View. Orientation for buildings is set on page one of its Object Properties Panel in 
the Heading: field. 

Below in alphabetical order are the different types of objects that are available in S.C.S. - 
Dangerous Waters. A page-by-page description of the properties that can be set for each type of 
object follows the name of each object type.  

9 Note: Trigger Object Properties Panel pages are covered separately in Triggers/Global Trigger 
Object Properties Panel Pages on p. 44 or Attached Trigger Object Properties Panel Pages on 
p.49. 

AIR CORRIDOR PROPERTIES 
Air corridors are added from an airport’s Mission Object menu or with the Editor menu’s Add>Add 
Air Corridor option. Click one of the end points to display these Object Properties Panel pages. 
An Air Corridor is a flight path aircraft take during the mission. Air corridors can be attached to 
airports or can be independent flight paths traversing the mission area. You can change air corridor 
options such as the type of aircraft and rate of generation in the Object Properties Panel. 

9 Note: For an air corridor attached to an airport, click the endpoint at the edge of the map to 
select the air corridor and display its Property Panels. You must add aircraft to the air corridor even 
if there are aircraft added to the airport. Airport aircraft will not show up in the air corridor’s 
Available Aircraft list. 
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PAGE ONE 
Corridor Width: Set the width (in miles) of the air corridor. 
Plane Generation per Hour: Set the rate planes to be generated. This is the number of planes per 
hour of the type set on page two. 
Plane Direction: Toggle button to set the direction aircraft travel in the air corridor. 
Minimum Altitude: Set the minimum altitude aircraft can fly in the air corridor. 
Maximum Altitude: Set the maximum altitude aircraft can fly in the air corridor. 
IFF: Set the IFF (Identification Friend or Foe) mode to none, friend, or civilian. 

PAGE TWO 
Available Aircraft: List of aircraft that are available to populate the air corridor. If nothing appears 
in the list, aircraft must be added using the Add AirCraft button below the list box. 
Add AirCraft: Add the planes that will populate the Air corridor.  

1. Click the Add Aircraft button. The Add Plane to Airport Dialog box appears. 
2. Select a Country, Class and the Name of an aircraft from the designated drop-down lists in the 

dialog box. 
3. Designate the number of aircraft to be available in this Air Corridor. 
4. Click OK. 
Delete AirCraft: Select an aircraft type from the Available Aircraft list, then click Delete AirCraft to 
remove that class of aircraft from the air corridor. 

9 Note: The Plane Generation per Hr value on page one of the air corridor’s Object Properties 
Panel determines how many planes are in the corridor at a time. When the total number of planes 
is exhausted, the air corridor becomes idle. 

AIR STATION PROPERTIES 
Air Stations can only be added to ships with embarked aircraft using the ship’s Mission Object 
menu’s Add Air Station option. Click an Air Station icon to bring up the Air Station Properties Panel 
pages. 

PAGE ONE 
Name: Create a name for the Air Station. Default is simply Air Station with a number appended as 
needed. 
Assigned Aircraft 1: Select aircraft to be assigned to the station from the Assigned Aircraft drop-
down list. 
Aircraft 1 Loadout: Select the Mission Type. This determines the kind of weapons the aircraft 
carries in the mission.  
Assigned Aircraft 2 Select aircraft to be assigned to the station from the Assigned Aircraft drop 
down list. 
Aircraft 2 Loadout: Select the Mission Type. This determines the kind of weapons the aircraft 
carries in the mission. 
Altitude: Set the altitude in feet for the aircraft at this station. 

9 Note: An air station may contain one or two aircraft. Aircraft fly a predetermined pattern when 
on station. 
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AIRPLANE PROPERTIES 
See Mission Editor/Object Properties Panel/Inflight Aircraft Properties on p. 36. For information on 
selecting weapons loadouts for aircraft assigned to an air station, see Mission Editor/Object 
Properties Panel/Air Station Properties above. 

AIRPORT PROPERTIES  
The land-based airport building object has some properties in common with ships with embarked 
aircraft. In addition to the three Building Object Properties Panel pages, a fourth page is available 
for airports. 

PAGE ONE 
Side: Select the object’s side. 
Name: Select the specific building object name. 
Heading: Set the orientation of the building object. Enter a number 0 to 360 to designate the 
direction that the building faces. 
Include in Sim: Specifies whether the selected airport is added to the mission as a simulation 
object.  
Airport simulation objects can be detected and marked. If the airport emits radar it can also be 
detected and marked by ESM. Detected airport objects can be targeted with land attack missiles 
during gameplay. Airports that are not simulation objects appear in 3D but cannot be marked or 
destroyed in the mission. 
Auto Detect: Specifies whether or not the airport is always visible during a mission. When this 
option is selected the airport appears on the Nav Map only when Show Link Data is ON. (See 
Navigation Station/2D Navigation Map. Ownship and Link Participant Platform IDs in the S.C.S. – 
Dangerous Waters User Manual) 

Mission Creation Tip: If you select Auto Detect for an object you must also select Include in Sim if 
you want to be able to destroy the object in the game.  

PAGE TWO 
Probability of Inclusion: This is the percentage chance an object appears at the start of the 
mission. If the object is in a group, then this probability is used to determine if the object will be 
included when the group is created. 
Latitude: Shows the latitude of the airport. Enter the desired latitude if a precise location is 
required. 
Longitude: Shows the longitude of the airport. Enter the desired longitude if a precise location is 
required. 
Alternatively you can click and drag the airport’s icon to the desired latitude/longitude location and 
release the mouse button.  

PAGE THREE 
Grounded Aircraft Selected: Lists the aircraft that are available at this airport. Aircraft must be 
added before they will appear in the Grounded Aircraft list. Use the Add Aircraft button to add 
aircraft.  
Add Aircraft: Click to bring up the Add Aircraft to Airport Dialog.  
1. When the Add Plane to Airport Dialog box appears, select a Country, Class and the Name of 

an aircraft from the drop-down lists in the dialog box. 
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2. Designate the number of aircraft to be available at this airport. 
3. Click OK. Repeat to add aircraft of different types. 
Delete Aircraft: Select an aircraft type from the Grounded Aircraft Selected list, then click the 
Delete Aircraft button to remove that class of aircraft from the airport. 
Add Inflight Aircraft: Click this button, then click the map to place aircraft aloft at the start of the 
game. The number of aircraft in the air is subtracted from the planes grounded at the airport. You 
must place planes at the airport before you can add inflight aircraft. You must then assign 
properties to these inflight aircraft by selecting the inflight aircraft’s icon and designating properties 
on their Properties Panel. See Mission Editor/Object Properties Panel/Inflight Aircraft Properties on 
p. 36. 
Add Corridor: Adding an air corridor from an airport works the same way as adding a regular air 
corridor except that one end of the air corridor is anchored at the airport. Click the white square at 
the outer end of the corridor to select it. See Mission Editor/Object Properties Panel/Air Corridor 
Properties on p. 30. 

9 Note: The Plane Generation per Hr value on page one of the air corridor’s Object Properties 
Panel determines how many planes are in the corridor at a time. When the total number of planes 
is exhausted, the air corridor becomes idle. 

PAGE FOUR 
This page contains the 3D model of the selected object. 

S.C.S. - Dangerous Waters Tip: Use the 3D model to determine if the airport is at an appropriate 
altitude. If the airport appears to be floating or buried, adjust the location of the airport. 

DYNAMIC LOCATION PROPERTIES 
There are two pages of object properties for the dynamic location.  

PAGE ONE 
Name: Specify the name of this dynamic location. By default the name is Location with a possible 
numeric suffix to keep it unique. 
Objects Assigned: Use the Add and Delete buttons to add objects in the scenario to this dynamic 
location or to delete objects from this dynamic location. You can add any submarine, ship, aircraft, 
environmental, or land-based object currently in the mission. 
Generation Options: Specify the minimum and maximum number of objects, from the list of 
objects in the Objects Assigned table, that will be selected to appear at this location when the 
mission starts. 

PAGE TWO 
Locations Assigned: This feature allows you to link two or more dynamic locations together. 
Objects from a single list of potential objects will be added to these locations randomly at game 
start. 

Click Add, move the cursor to the map where the cursor changes to +. Click on the map to add 
another dynamic location linked to the previous location. Repeat to create a group of linked 
dynamic locations. At mission start, a random number of objects between the min and max number 
will be selected and placed at one of the randomly selected dynamic locations. The selected 
objects will maintain all their properties such as course, speed, depth, tactic, etc. The relative 
placement between the objects will also be maintained. 
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ENVIRONMENTAL PROPERTIES 
There are three pages of object properties for the environmentals.  

PAGE ONE 
Name: Specify the type of the selected environmental. The environmental type selected when the 
environmental was created is shown by default. 
Tactic: Choose the object’s tactic from one of those listed. Click in the map and drag to place the 
tactic around the platform. To delete the current tactic just select a different tactic from the drop-
down list. Descriptions of all tactics are described in Appendix A: Tactics on p. 65. 
Speed: Enter the desired speed of the platform in knots. 
Depth: Specify the depth of the selected environmental.  
Include in Sim: Specifies whether the selected environmental is added to the mission as a 
simulation object. Environmental simulation objects can be detected and marked, and can be 
targeted with weapons during gameplay. Environmental objects that are not simulation objects 
appear in 3D but cannot be marked or destroyed in the mission. 
Unique name: The editor will assign a default unique name base on the type of object. You may 
change the name, but the editor may append a number to the end if required to keep the name 
unique from all other object names in the scenario. 

PAGE TWO 
Probability of Inclusion: This is the percentage chance an object appears at the start of the 
mission. If the object is in a group, then this probability is used to determine if the object will be 
included when the group is created. 
Latitude: Shows the starting latitude of the object. Enter the desired latitude if a precise location is 
required. 
Longitude: Shows the starting longitude of the object. Enter the desired latitude if a precise 
location is required. 
Alternatively you can click and drag the object’s icon to the desired latitude/longitude location and 
release the mouse button.  

PAGE THREE 
Page three displays the 3D object.  

LAND-BASED/BUILDING PROPERTIES 
Buildings (land-based objects) must be placed on land. There are three pages of properties for 
buildings. Buildings with helicopter pads will have fourth page to add helicopters. 

PAGE ONE 
Side: Select the object’s side. 
Name: Select the specific building object name. 
Heading: Set the orientation of the building object. Enter a number 0 to 360 to designate the 
direction the building faces. 
Include in Sim: Specifies whether the selected building is added to the mission as a simulation 
object.  
Land-based simulation objects can be detected and marked. If the land object emits radar it can 
also be detected and marked by ESM. Detected land simulation objects can be targeted with land 
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attack missiles during gameplay. Buildings that are not simulation objects appear in 3D but cannot 
be marked or destroyed in the mission.  

Mission Creation Tip: To add a building to your scenario for visual effect, without impacting 
gameplay, deselect the Include in Sim option. The selected building appears in the 3D view but is 
not included in the mission play (i.e. you can’t mark or target it and it doesn’t appear on the Nav 
map). Including too many buildings in the sim slows down the simulation and dramatically reduces 
frame rate.  

Auto Detect: Specifies whether or not the building is always visible during a mission. When this 
option is selected the object appears on the Nav Map only when Show Link Data is ON. (For more 
information on Link functionality see Main Menu/Options/Game/Show Link Data is Section 3 of the 
S.C.S. – Dangerous Waters User Manual.) 

Mission Creation Tip: If you select Auto Detect for an object you must also select Include in Sim if 
you want to be able to destroy the object in the game.  

PAGE TWO 
Probability of Inclusion: This is the percentage chance an object appears at the start of the 
mission. If the object is in a group, then this probability is used to determine if the object will be 
included when the group is created. 
Latitude: Shows the starting latitude of the platform. Enter the desired latitude if a precise location 
is required. 
Longitude: Shows the starting longitude of the platform. Enter the desired latitude if a precise 
location is required. 
Alternatively you can click and drag the platform’s icon to the desired latitude/longitude location and 
release the mouse button.  

PAGE THREE (IF HELICOPTER PAD EXISTS) 
Grounded Aircraft Selected: Lists the aircraft (helicopters only) that are available at this building. 
Aircraft must be added before they will appear in the Grounded Aircraft list. Use the Add Aircraft 
button to add aircraft.  
Add Aircraft: Click to bring up the Add Aircraft to Airport Dialog.  
1. When the Add Plane to Airport Dialog box appears, select a Country, Class, and the Name of 

an aircraft from the drop-down lists in the dialog box. 
2. Designate the number of aircraft to be available at this airport. 
3. Click OK. Repeat to add aircraft of different types. 
Delete Aircraft: Select an aircraft type from the Grounded Aircraft Selected list, then click the 
Delete Aircraft button to remove that class of aircraft from the list of available aircraft. 
Add Inflight Aircraft: Click this button, then click the map to place aircraft aloft at the start of the 
game. The number of aircraft in the air is subtracted from the planes grounded at the airport. You 
must place planes at the airport before you can add inflight aircraft. You must then assign 
properties to these inflight aircraft by selecting the inflight aircraft’s icon and designating properties 
on their Properties Panel. See Mission Editor/Object Properties Panel/Inflight Aircraft Properties on 
p. 36. 

PAGE THREE (PAGE FOUR IF HELICOPTER PAD EXISTS) 
This page contains the 3D model of the selected building object.  
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9 Note: Trigger Properties Panel pages are covered separately in Triggers/Global Trigger 
Object Properties Panel Pages on p. 44 or Attached Trigger Object Properties Panel Pages on p. 
49. 

HELICOPTER PROPERTIES 
See Inflight Aircraft Properties below. 

INFLIGHT AIRCRAFT PROPERTIES 
Inflight aircraft can be airplanes or helicopters. There are four pages of properties available for 
inflight aircraft. Click the inflight aircraft’s icon to select its Object Properties Panel pages. 

PAGE ONE 
Name: Choose the type of aircraft to be placed.  
Tactic: Choose the tactic the aircraft performs. For descriptions of these tactics, see Appendix A: 
Tactics  

9 Note: One tactic available to ASW aircraft that carry sonobuoys is a Sonobuoy Search tactic. 
Select Sonobuoy Search from the Tactic list then use the cursor to drag a box on the Mission Map 
where the ASW helicopter or aircraft is to drop sonobuoys to search for submarines. 

Speed: Set the aircraft’s speed in knots. 
Altitude: Set the aircraft’s altitude in feet. 
Weapon Loadout: Select Naval Warfare Mission Area assignment for the aircraft. Weapons 
appropriate for the mission type are loaded on the aircraft at mission start.  
IFF: Set the IFF (Identification Friend or Foe) mode to none, friend, or civilian. 
Unique name: The editor will assign a default unique name base on the type of object. You may 
change the name, but the editor may append a number to the end if required to keep the name 
unique from all other object names in the scenario. 

PAGE TWO 
Probability of Inclusion: This is the percentage chance an object appears at the start of the 
mission. If the object is in a group, then this probability is used to determine if the object will be 
included when the group is created. (If there is only one controllable aircraft in the mission, this 
should be set to 100. (Default is 100.) 
Latitude: Shows the starting latitude of the platform. Enter the desired latitude if a precise location 
is required. 
Longitude: Shows the starting longitude of the platform. Enter the desired longitude if a precise 
location is required. 
Alternatively you can click and drag the platform’s icon to the desired latitude/longitude location and 
release the mouse button.  
Controllable Platform: When checked, this aircraft object can be selected as the controllable 
platform in the Mission Selection screen. This option only appears if the aircraft object is the U.S. 
MH-60R Seahawk helicopter or the U.S P-3 Orion. 

PAGE THREE (NON-CONTROLLABLE AIRCRAFT) 
Source Object: Displays the platform at which the aircraft is stationed. 
Inflight Aircraft: Specify whether or not the aircraft is to begin the mission airborne. 
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Aircraft with Launch Time: When this option is selected the Launch Time box appears in which 
you set the time the aircraft launches from its source object. For example, if the mission begins at 
08:00, setting the launch time to 08:15 makes the aircraft launch 15 minutes after the mission’s 
start. This option does not appear if the aircraft designated a Controllable Platform. 
Refresh Station: Causes the aircraft’s source object to automatically begin preparing another 
aircraft to take its place when that aircraft returns or is shot down. This option does not appear if 
the aircraft designated a Controllable Platform. 

PAGE THREE (CONTROLLABLE AIRCRAFT) 
These options appear on page three if the aircraft is designated as a Controllable Aircraft on page 
two. 
Tasking Message: Enter the text that appears in the Tasking Message on the Mission Selection 
Screen and in the Mission Brief. The text before a hard return displays in the Tasking window in 
Mission Selection. The entire message displays on the Mission Brief screen. 
Player Has Choice of Platform: Selecting this option places *Controllable Air in the Controllable 
Platform Selector on the Mission selection screen. When multiple aircraft platforms are available in 
an aircraft class specified on page one, selecting this option allows the player to choose which one 
to control when the mission is selected. At the time of this writing, only one aircraft of each class 
exists, so this option effectively does nothing.  
If the aircraft is designated a Controllable Platform, then the following options appear on page four. 
Otherwise, they appear on page three. 
Stream Dipping Sonar: This option only appears if the controllable platform is the MH-60R. When 
this option is selected, the MH-60R begins the mission with its dipping sonar already deployed. 
Make sure you set the speed to 0 knots and an altitude of 50 – 100 feet. 

9 Note: If, after specifying aircraft with a specific launch time, you decide to change the scenario 
start time, your aircraft launch time is automatically updated to occur within the same elapsed time 
interval from the original scenario start time. For example, if the mission begins at 08:00 and the 
aircraft launch time is 08:15, changing the scenario start time to 06:00 causes the aircraft launch 
time to be updated to 06:15.  

PAGE FOUR/FIVE 
This page contains the 3D model of the selected aircraft object. 

MINE PROPERTIES 
When a mine is selected on the map, the following options for that mine appear on the Object 
Properties Panel.  

PAGE ONE 
Side: Assign the side to which the mine belongs. 
Name: Specify the type of the selected mine. The mine type selected when the minefield was 
created is shown by default. 
Depth: Specify the depth of the selected mine. The depth in feet designated when minefield was 
created is shown by default.  

PAGE TWO 
Probability of Inclusion: This is the percentage chance an object appears at the start of the 
mission. If the object is in a group, then this probability is used to determine if the object will be 
included when the group is created. 
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Latitude: Adjust the latitude of the mine. 
Longitude: Adjust the longitude of the mine. 
Unique name: The editor will assign a default unique name base on the type of object. You may 
change the name, but the editor may append a number to the end if required to keep the name 
unique from all other object names in the scenario. 

PAGE THREE 
This page contains the 3D model of the selected mine object. 

SHIP PROPERTIES 
There are three pages of object properties for most ships. Aircraft Carriers and ships with 
embarked helicopters have a fourth page shown below. If the ship is designated as a Controllable 
Platform on page two, there is an additional 5th page inserted. 

PAGE ONE 
Side: Select the object’s side. You can designate up to seven sides plus neutral. To set alliances 
between sides, see Mission Editor/Editor Menu/Setup Menu/Side Alliances on p. 20. 
Country: Select the object’s nation. 
Class Designation: Select the object’s class. 
Name: Select the specific vessel name, or hull number for some classes. 
Tactic: Choose the object’s tactic from one of those listed. Click in the map and drag to place the 
tactic around the platform. To delete the current tactic just select a different tactic from the drop-
down list. Descriptions of all tactics are described in Appendix A: Tactics on p. 65. 
Speed: Enter the desired speed of the platform in knots. 
Target Mode: Assign a special tactic for the object to follow when it encounters the platform 
selected in Target Platform drop-down.  

None: No special tactic is assigned. The object uses the tactic assigned in the Tactic drop-
down. 
Attack: The object attacks the platform selected in Target Platform as soon the object detects 
the platform. 
Track: The object tracks (trails) the platform selected in Target Platform as soon as the object 
detects the platform. 

Target Platform: Lists all objects in the mission. The object applies the Target Mode set above to 
the platform selected in this drop-down. 

9 Note: Any entries made in Tactics, Target Mode and Target Platform are disregarded if the 
ship is a controllable ship selected by a player. The player determines all tactics. Currently the only 
controllable surface ship is the O.H. Perry FFG 7 class. See Page Three (Controllable FFG) below. 

PAGE TWO 
Probability of Inclusion: This is the percentage chance an object appears at the start of the 
mission. If the object is in a group, then this probability is used to determine if the object will be 
included when the group is created. (If there is only one controllable ship in the mission, this should 
be set to 100. (Default is 100.) 
Latitude: Shows the starting latitude of the platform. Enter the desired latitude if a precise location 
is required. 
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Longitude: Shows the starting longitude of the platform. Enter the desired longitude if a precise 
location is required. 
Alternatively you can click and drag the platform’s icon to the desired latitude/longitude location and 
release the mouse button.  
EMCON: When checked, the EMCON (Emission Control) mode of the platforms active sensors is 
set to off/not radiating. 
Controllable Platform: When checked, this ship object can be selected as the controllable 
platform in the Mission Selection screen. This option will only appear if the ship object is the U.S. 
Oliver Hazard Perry class FF. 
Unique name: The editor will assign a default unique name base on the type of object. You may 
change the name, but the editor may append a number to the end if required to keep the name 
unique from all other object names in the scenario. 

PAGE THREE (CONTROLLABLE FFG) 
If the ship is designated as a Controllable Platform, the following options appear on page three.  
Tasking Message: Enter the text that appears in the Tasking Message on the Mission Selection 
Screen and in the Mission Brief. The text before a hard return displays in the Tasking window in 
Mission Selection. The entire message displays on the Mission Brief screen. 
Player Has Choice of Platform: Selecting this option places *Controllable Surface in the 
Controllable Platform Selector on the Mission selection screen. When multiple hulls are available in 
the class that is selected on Page one, selecting this option gives the player the choice of which 
hull in the class to control when the mission is selected.  As of this writing only the U.S. O.H. Perry 
class can designated as a controllable ship.  
Stream TA: When selected the ship’s Towed Array is already deployed at mission start. 

9 Note: For ships not designated as a Controllable Platform but with embarked aircraft, page 
three displays the following options. For controllable surface ships, the following options appear on 
page four. 

PAGE THREE/FOUR 
These options appear on page three for aircraft carriers and ships with embarked aircraft and on 
page four for the Controllable FFG. 
Aircraft Available: Shows the aircraft available on the selected ship or carrier.  
Aircraft Loadout: Allows the mission designer to select a specific type of loadout for the selected 
aircraft class if the class has more than one loadout available. Some aircraft have only a default 
loadout. 
Add Inflight Aircraft: Allows inflight aircraft to be placed in the mission.  
B Click ADD INFLIGHT AIRCRAFT then click the map to place an aircraft icon. (You must 

select the aircraft icon and set its properties separately. 
See Mission Editor/Object Properties Panel/Inflight Aircraft Properties on p. 36. 
Add Air Station: Allows two planes to be placed at an air station. 
B Click ADD AIR STATION then click the map to place the air station. Select the air station’s 

icon to assign aircraft and set its properties. 
See Mission Editor/Object Properties Panel/Air Station Properties on p. 31. 
For ships not designated as a Controllable Platform and with no embarked aircraft, page three 
displays the 3D object.  
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PAGE THREE/FOUR/FIVE 
Page three, four, or five displays the 3D model for the selected platform depending on which 
platform is selected. 

SUBMARINE PROPERTIES 
There are four pages of submarine properties for most submarines. If the submarine is designated 
as a controllable platform, there are five pages. 

PAGE ONE 
Side: Select the object’s side. You can designate up to seven sides plus neutral.  
Country: Select the object’s nation. 
Class Designation: Select the object’s class. 
Name: Select the specific vessel name, or hull number for some classes. 
Tactic: Choose the object’s tactic from the drop-down list. Tactics are listed and described in 
Appendix A: Tactics on p. 65. After the tactic is selected, the Description Bar prompts you to 
position the object tactic on the Mission Map. Click in the map and drag to place the tactic around 
the platform. To delete the current tactic and place another, just select a different tactic from the 
drop-down list.  
Speed: Enter the desired speed of the submarine at mission startup. 
Depth: Enter the depth for the submarine at mission startup. If you enter a depth less than the 
submarine’s surfaced depth, the game places that submarine on the surface at game start. 
Target Mode: Assigns a special tactic for the object to follow when it encounters the platform 
selected in Target Platform drop-down.  

None: No special tactic is assigned. The object uses the tactic assigned in the Tactic drop-
down. 
Attack: The object attacks the platform selected in Target Platform as soon the object detects 
the platform. 
Track: The object tracks (trails) the platform selected in Target Platform as soon as the object 
detects the platform. 

Target Platform: Lists all objects in the mission. The object applies the Target Mode set above to 
the platform selected in this drop-down. 

9 Note: Any entries made in Tactics, Target Mode, and Target Platform are disregarded if the 
sub is a controllable sub selected by a player. The player determines all tactics. 

PAGE TWO 
Probability of Inclusion: This is the percentage chance an object appears at the start of the 
mission. If the object is in a group, then this probability is used to determine if the object will be 
included when the group is created. (If there is only one controllable sub in the mission, this should 
be set to 100. (Default is 100.) 
Latitude: Shows the starting latitude of the platform. Enter the desired latitude if a precise location 
is required. 
Longitude: Shows the starting longitude of the platform. Enter the desired longitude if a precise 
location is required. 
Alternatively you can click and drag the platform’s icon to the desired latitude/longitude location and 
release the mouse button.  
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Controllable Platform: When checked, this submarine object can be selected as the controllable 
platform in the Mission Selection screen. This option is only available if the selected object has 
been designated as one of these sub classes on page one:  

U.S. Seawolf, 688(I) 
Russia: Akula-I Improved (SSN), Akula II (SSN), Kilo SS, Kilo Improved SS. 
China: Kilo SS, Kilo Improved SS. 

Unique name: The editor will assign a default unique name base on the type of object. You may 
change the name, but the editor may append a number to the end if required to keep the name 
unique from all other object names in the scenario. 
 

Mission Creation Tip: Place more than one controllable platform in a mission to make the mission 
a Multiplayer mission. The number of controllable platforms placed in the mission determined the 
number of players that can play in a game. Each controllable platform can be given separate 
tasking. 

PAGE THREE  
The 3D model in use for the specified submarine class appears on page three for platforms that are 
not controllable subs. 

PAGE THREE (CONTROLLABLE SUBS) 
 If the submarine is designated a Controllable Sub the following options appear on page three. 
Tasking Message: Enter the text that appears in the Tasking Message on the Mission Selection 
Screen and in the Mission Brief. The text before a hard return displays in the Tasking window in 
Mission Selection. The entire message displays on the Mission Brief screen. 
Player Has Choice of Platform: Selecting this option places *Controllable Sub in the 
Controllable Platform Selector on the Mission selection screen. The *Controllable Sub option gives 
the player the opportunity to select any sub (U.S. or Russian) listed in the Specific Sub Selector.  
When this option is not selected, only the submarine named on page one is available to command 
in the Mission Selection screen for this Controllable Sub. (See Note below.) 

Mission Creation Tip: Make sure that your tasking message is appropriate for any selectable sub 
regardless of country when using the Player Has Choice of Platform option. 

Stream TA: When selected the sub’s Towed Array is already deployed at mission start.  

PAGE FOUR (CONTROLLABLE SUBS) 
Objects Available: Lists the objects that are included in the selected loadout from the Objects 
Loadout option. Possible available objects are none, a DSRV, and a Special Forces Unit. 
Object loadouts: Select from the Default Loadout or one of the available additional Loadouts. The 
objects contained in the select Loadout will appear in the Objects Available window. The loadouts 
available include Special Forces and deep submergence rescue vehicles (DSRVs). DSRVS are 
listed by their actual names (Mystic and Avalon for the US platforms and ARS- 1 YSS and Bester 
YSS for the Chinese and Russian controllable platforms. 

9 Note: It is recommended that you not select Player Has Choice of Platform for a submarine 
that is loaded out with a DRSV. The Russian 'Bester' DSRV model used by the Russian and 
Chinese submarines in S.C.S. - Dangerous Waters has different dimensions from those of the U.S. 
DSRV. Designating a sub as Player Has Choice results in the DSRV appropriate for the initially 
placed submarine appearing on any controllable submarine at the player's choice. There is a 
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chance of the DSRV colliding with Ownship or of the DSRV appearing several meters above the 
deck depending on which country's sub was initially placed in the mission.  

PAGE FIVE (CONTROLLABLE SUB) 
When a submarine is designated as a Controllable Sub, its 3D object displays on page five. 
Otherwise, it appears on page four. 

TEXT LABEL PROPERTIES 
There is one page in the Text Label Properties Panel. There are two ways to place a text label. 
B From the Mission Map menu select Chart Text Label then click the map.  

or 
B From the Editor menu select Add>Add Chart Text Label. 

These options are available on the Properties Page for text labels. 
Label: Displays a default text label with a sequential number appended. Click in the edit box and 
type in the desired text for the label. 
Color: Select the desired color for the text label from the drop-down list. Eight colors are available. 

WAYPOINT PROPERTIES 
Each waypoint has one page of proprieties. Platforms can be assigned changes in speed and 
additional tactics to accomplish when the selected waypoint is reached. 
The platform’s estimated time of arrival at that waypoint displays at the top of the page. 

9 Note: The speed, depth (subs) and altitude (aircraft) values that appear as default for each 
waypoint are those in effect for the source object at the time the waypoints were placed. For 
example, if a sub is given a speed of 3 knots on page one of its Object Properties Panel pages 
when waypoints are assigned, all waypoints are set at a speed of 3 knots, even if the speed on 
page one is subsequently changed. 

Speed: Set the speed the platform should maintain after it reaches the selected waypoint. 
Depth: Set the depth the submarine should maintain after it reaches this waypoint. (Available for 
submarine waypoints only.) 
Altitude: Set the Altitude the platform should maintain after it reaches this waypoint. (Available for 
aircraft waypoints only.) 
Tactic: Select an additional tactic for the platform to initiate when it reaches this waypoint. A 
description of tactics in this list is found in Appendix A: Tactics on p. 65. 
Tactic Duration: Designate how long the platform should perform the new tactic before proceeding 
to the next waypoint. By way of example, assume a set of four area waypoints are assigned to a 
sub. For this example we designate them waypoints A, B, C, and D.). Suppose Waypoint A is 
selected on the Mission Editor map and a new tactic of additional area waypoints are assigned. 
These are designated as A-1, A-2, A-3, and A-4) When the sub reaches Waypoint A during 
gameplay, the sub follows the new waypoints (A-1, A-2, etc.) only as long as the time set in Tactic 
Duration field, even if the sub has not reached all of the waypoints in the new set. At the end of the 
duration time, the sub reverts to its original waypoint assignment and heads for Waypoint B at the 
speed, depth, tactic, and in the Target mode set in Waypoint A's Properties Panel page one. 
 
Target Mode: Assigns a special tactic for the object to follow when it encounters the platform 
selected in Target Platform drop-down. 
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None: No special tactic is assigned. The object uses the tactic assigned in the Tactic drop-
down. 
Attack: The object attacks the platform selected in Target Platform as soon the object detects 
the platform. 
Track: The object tracks (trails) the platform selected in Target Platform as soon as the object 
detects the platform. 

Target Platform: Lists all objects in the mission. The object applies the Target Mode set above to 
the platform selected in this drop-down. 
Script To Run: Select a script to run when the platform reaches this waypoint. For information on 
creating scripts see Mission Editor/Scripts on p. 54. 
Tolerance (nmi): The distance at which the platform is considered to have reached the waypoint. 
A tolerance of 0.0 will implement default behavior. If the waypoints are positioned close together, 
relative to the turning diameter of the platform, increasing the Tolerance will stop the platform from 
circling but never reaching a waypoint. 
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TRIGGERS 
Triggers are the means by which you assign specific tasks to the player, provide him or her with 
intelligence information, and trigger tasking messages during gameplay. Triggers are also used to 
initiate events at a specific time in the mission or to test that events have occurred in order to 
trigger other events or to evaluate the player’s performance. Platforms other than those controlled 
by the player can also be assigned specific tasks that impact the player’s experiences in the game.  

There are two classes of triggers: Global Triggers and Attached Triggers. Each class of trigger 
has two types: Goal and Event. Goal triggers test for the completion of certain requirements by 
the platforms in a mission needed to satisfy the requirements for mission tasking. Event triggers 
test for the occurrence of certain events in order to trigger other events or to test for goal 
completion.. 

GLOBAL TRIGGERS 
A global trigger is not attached to a specific object but you can designate specific criteria for trigger 
accomplishment. There are two types of global triggers, Goal and Event. Both types are described 
below. Both of these global goal types can test for three different trigger activation criteria: arrival at 
a destination, automatic activation, and activation by aggregating completion of other triggers. See 
Global Trigger Object Properties Panel Pages on p. 44. Attached Triggers are described on p. 49. 

To place a global trigger: 
1. Click the Trigger button at the bottom of the screen. 
2. Click the location on the map where the trigger is to be placed. A trigger icon can be moved to 

a different location by clicking on the trigger icon and dragging it to a new location or by setting 
a specific longitude and latitude on page two of its Object Properties Panel pages. 

3. Click the trigger icon to select it. The Trigger Object Properties Panel appears to the right of the 
map. See Global Trigger Object Properties Panel Pages below. 

Mission Creation Tip: Automatic global triggers are useful for sending “mission complete” 
messages to the player. In the Trigger Precedence dialog for an Automatic Trigger or in the 
doctrine statements contained in the trigger, specify that this trigger cannot be triggered until all 
other required triggers in the mission are completed. Once all the other required triggers are 
completed, the “mission complete” trigger is automatically triggered. (See Mission 
Editor/Triggers/Trigger Precedence on p. 52.) 

GLOBAL TRIGGER OBJECT PROPERTIES PANEL PAGES 
Each type of trigger has a different number of property pages. There is always an extra page of 
properties if Use Doctrine Language is selected. This selection displays the Doctrine Editor on the 
additional page. For information on the use of Doctrine Language and the Doctrine Editor, see 
Doctrine Language on p. 58. 

Page One 
All trigger types contain these option fields on page one. 
Apply Trigger To: Options in the list include ALL and any controllable platform in the mission. 
When a specific controllable platform is selected in this drop-down, this trigger is only generated in 
the game if the player selects that platform to command. 
Trigger Name: Assign the trigger a name. The default trigger name is Trigger with a sequential 
number appended. This trigger name appears in the Mission Status Screen and in the Mission 
Debrief and Player’s Log if the trigger type is selected as goal type. 
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Mission Creation Tip: Specifying a Trigger Name that indicates the purpose of the trigger may 
make it easier to set trigger precedence and test for trigger completion in doctrine statements as 
well as aid you in remembering what the trigger was created to accomplish. 

Trigger Type: Specify the trigger type – Goal or Event. The trigger activation types vary depending 
on which trigger type is selected. 

Trigger Activation: (Global Triggers) 
� Destination: tests for the arrival of a platform at the position of the Global Trigger within 

the constraints of the criteria found on later pages. 

� Automatic: the trigger fires automatically upon meeting the criteria found on later pages. 

� Aggregate: the trigger fires upon meeting the minimum number of successful triggers as 
defined in later pages. 

Critical: (Appears only when Goal Trigger is selected.) Specifies that this trigger must be 
completed in order to complete the mission. Applies only for goal triggers. More than one goal 
trigger can be marked as critical. 

Can Refire: (Appears only when Event Trigger is selected.) Specifies that this trigger can be 
reset so that if the trigger criteria are met again, the trigger will refire. Applies to event triggers only.  

Reset Time: (Appears only when Can Refire is selected) Set the minimum time that must expire 
before the trigger can refire. Time Format: Hours: Minutes: Seconds, relative time. 

Page Two (Destination Activation) 
Object to complete Trigger: Set the side, country, and/or class of the object required to complete 
this destination trigger. 

9 Note: You may leave any of these fields blank, meaning that any value is valid for that field. 
For example, if you select "United States" for the country and leave the rest of the fields blank, any 
United States platform on any side can satisfy this trigger. Similarly you can set the side 
specification to side 1, and leave the rest of the fields blank. Then any platform on side 1 can 
accomplish the trigger. 

Return to Base: If the object selected in the previous option is an aircraft, select this option if part 
of the criteria to satisfy this trigger is that the aircraft return to its base after meeting all the other 
criteria in the trigger. 

Max Speed: Set the maximum speed allowable for trigger completion. Set –1 to require no specific 
speed for trigger completion. (Destination and Approach triggers only) 

Depth Check: Select the type of depth criteria from either Min-Max Depth or On Land. If Min-Max 
Depth is selected then the following two options appear. 

Min Depth: Set the minimum depth allowable for trigger completion. Set –1 to require no 
specific minimum depth for trigger completion. If the platform is an aircraft enter the minimum 
altitude for the platform.  
Max Depth: Set the maximum depth allowable for trigger completion. Set –1 to require no 
specific maximum depth for trigger completion. If the platform is an aircraft enter the maximum 
altitude. 

If On Land is selected, then the Object must be on the terrain to satisfy the criteria. 

Page Two (Aggregate Activation) 
The Aggregate Settings are comprised of two options as follows: 

Minimum Num Successful Triggers: Set the minimum number of successful triggers required to 
complete this trigger. 
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Dependent Triggers: Use the Add and Remove buttons to construct the list of triggers that can 
be tested in the preceding option. 

Page Two (Automatic Activation)  
Use Doctrine Language: When selected, an additional page is added containing the Doctrine 
Editor. The Doctrine Editor allows for the creation of doctrine expressions to further refine the event 
trapping conditions of this trigger. The Doctrine Editor is covered in Doctrine Language later in this 
manual on p. 58 

Start/End Time: Specify the time within which the trigger must be completed. If you do not select a 
start or end time, this trigger can be accomplished at any time during the mission. (Option available 
for all trigger types.) Time Format: Days:Hours:Min  

Duration: The total time for which the criteria of the trigger must be true before the trigger will fire. 

Points: The number of points awarded the player for accomplishing this trigger. (Goal triggers 
only.) 

Radius: The radius in Nautical miles within which the designated object must arrive for the trigger 
to fire. 

Latitude: Displays the current latitude of the trigger object. To adjust the latitude of the trigger, type 
in a specific latitude coordinate. (Option not available for Automatic Triggers.) 

Longitude: Displays the current longitude of the trigger object. To adjust the longitude of the 
trigger, type in a specific longitude coordinate. (Option not available for Automatic Triggers.) 

Page Three (Destination/Aggregate) 
The properties described above in Page Two (Automatic Activation) appear on Page three when 
Destination or Aggregate activation is selected. See above.  

Page Three (Automatic Activation with Doctrine) 
If Use Doctrine Language is selected on page two, the Doctrine Editor appears on page three. See 
Doctrine Language on p. 58. 

Page Four (Destination/Aggregate Activation with Doctrine) 
If Use Doctrine Language is selected on page three for Destination or Aggregate Activation, the 
Doctrine Editor appears on Page four. This page is where the doctrine language statements are 
created and combined using Boolean logic. Information on the use of the Doctrine Editor is found in 
Doctrine Language on p.58. Doctrine commands are described in Appendix B: Trigger Doctrine 
Commands on p. 66. 

Page Three or Four or Five 
Communications: 
Specify the parameters of the communications message the player receives when the trigger is 
accomplished. During gameplay new communications messages are displayed in Report History 
window.  

Type: Allows the user to specify one of two types of communications: The type of message 
selected determines which Task Bar History Window displays the message during gameplay. 

Radio Message: A radio message provides further mission information or intelligence. (During 
gameplay a Radio message appears in the Radio History Window in the Task Bar. Radio 
messages can only be received on subs when they are at comms depth with the radio antenna 
raised or the floating wire deployed.) 
Report: A report can be used to notify the player of game related information such as ‘You 
have completed the trigger.’ (During gameplay a Report message appears in the Crew Report 
History window on the Task Bar.) 
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To: The platform selection referenced here applies to the platform that is to receive the message 
text (either radio or message) when the trigger completes. This allows you to set up multiplayer 
missions more easily. For example if you have a trigger for a FFG to hit a destination point, and 
you only want the player driving the helo to know about it, you can select the helo from this drop 
down list so only the helo receives this message rather than all the players in the game. When All 
Controllables is selected here, all players in the game, regardless of side, receive the message. If 
you want only the platform that triggers the goal is to be notified, select the same platform here as 
was selected in Applies To on page one. 

Text: Compose the text of the communications.  

Audio File: Specify a .wav file to be played when the message is displayed. Files should be in 
.wav format; 16 bit, mono, 22050 Hz sampling. 

To play your own custom .wav file, copy the .wav file to the Scenario directory (a subdirectory off 
of the path in which S.C.S. - Dangerous Waters was installed) on your hard drive. Enter the name 
of this new .wav file in the trigger Audio File box. 

9 Note: When creating text or sound for the final trigger of the game (i.e., the Mission Complete 
trigger), make sure that the communication message tells the player that the mission has been 
completed. Missions have no other time limit or ending point. 

9 Note: When designing multiplayer missions that have custom .wav files, participating players 
must have not only the scenario file but also the new .wav file(s). The other players should copy the 
.wav and scenario files to their Scenario directory. 

Page Four or Five or Six 
Trigger Complete Message: Enter a message that will appear in a pop up dialog box when the 
trigger is selected in the debrief screen if the trigger is completed.  

Trigger Incomplete Messages: Enter a message that will appear in a pop up dialog box when the 
trigger is selected in the debrief screen if the trigger is not completed.  

When the mission ends, the player reaches the Debrief screen where all the statistics of the 
mission are displayed. On this screen, all goal triggers are shown, along with their complete or 
incomplete status. If the trigger was successfully completed, clicking on the trigger name in the 
Debrief screen reveals the Trigger Complete message for that trigger. If the trigger was not 
accomplished, clicking on the trigger description displays the Trigger Incomplete message for the 
trigger.  

Page Five or Six or Seven 
Depending on which activation mode is selected and whether or not Use Doctrine Language is 
selected, the following properties appear on page five, six, or seven. 
Action 
Determine an action that takes place when the trigger is reached. The following options appear in 
the Action drop-down list. 
None: No action takes place. 
Create Objects: When this option is selected the following buttons appear in the panel. 

Add Group: Click to display the Add Group Dialog. A Group must already exist. When this 
trigger is triggered the group whose name is selected here is created. 
Delete Group: Select a group name in the Objects to Create list and click this button to delete 
the selected group from the creation list. 

9 Note: It is important that any group that is created by a trigger be given an inclusion probability 
of zero. This will ensure that this dynamic group will not be created when the scenario starts and 
will only be created when the trigger is activated. 
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Run Script: When this option is selected a Script to Run option will appear. Select the script 
to run. A script must already exist. When this trigger is triggered the script whose name is 
selected here is run. 
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ATTACHED TRIGGERS 
Attached Triggers are created specifically for one object. More than one Attached Trigger may be 
created for an individual object. An Attached Trigger can be either a goal trigger or an event trigger. 
Both of these attached goal types can test for four different trigger activation criteria: arrival at a 
destination, approach to another object, damage to the attached object, and attaining a relative 
position with respect to another object. For specific information on setting properties for Trigger 
objects see Mission Editor/Triggers/Attached Trigger Object Properties Panel Pages on p. 49. 

To create an attached trigger: 
1. On the map, right-click the object to be assigned the trigger. The Mission Object menu 

appears. 
2. From the Mission Object menu select Add Attached Trigger. 
3. Click the map where the trigger is to be placed. Click the trigger icon to select it and bring up its 

Trigger Object Properties Panel pages. 

9 Note: Only goal triggers can be assigned points and will appear in the Mission Debrief screen 
when the player ends the mission. 

ATTACHED TRIGGER OBJECT PROPERTIES PANEL PAGES 
Depending on the type of trigger selected there are a different number of property pages. There is 
always an extra page of properties if Use Doctrine Language is selected. This selection displays 
the Doctrine Editor on the additional page. For information on the use of Doctrine Language and 
the Doctrine Editor, see Doctrine Language on p. 58. 

Page One 
Apply Trigger To: Options in the list include ALL and any controllable platform in the mission. 
When a specific controllable platform is selected in this drop-down, this trigger is only generated in 
the game if the player selects that platform to command. 
Trigger Name: Assign the trigger a name. The default trigger name is Trigger with a sequential 
number appended. This trigger name appears in the Mission Status Screen and in the Mission 
Debrief and Player’s Log if the trigger type is selected as goal type. 
Trigger Type: Specify the trigger type – Goal or Event. The trigger activation types vary depending 
on which trigger type is selected. 
Trigger Activation: (Attached Triggers) 

� Destination: tests for the attached platform arriving at a specified location within the 
constraints of the criteria found on later pages. 

� Approach: tests for the attached platform approaching a specified object within the 
constraints of the criteria found on later pages. 

� Kill: tests for the attached platform damaging a specified object within the constraints of 
the criteria found on later pages. 

� Relative Position: tests for the attached platform obtaining a position with respect to 
another object within the constraints of the criteria found on later pages. 

Mission Creation Tip: Specifying a Trigger Name that indicates the purpose of the trigger may 
make it easier to set trigger precedence and test for trigger completion in doctrine statements as 
well as aid you in remembering what the trigger was created to accomplish. 
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Critical: (Appears only when Goal Trigger is selected.) Specifies that this trigger must be 
completed in order to complete the mission. Applies only for goal triggers. More than one goal 
trigger can be marked as critical. 

Can Refire: (Appears only when Event Trigger is selected.) Specifies that this trigger can be 
reset so that if the trigger criteria are met again, the trigger will refire. Applies to event triggers only.  

Reset Time: (Appears only when can Refire is selected) Set the minimum time that must expire 
before the trigger can refire. Time Format: Hours: Minutes: Seconds, relative time. 

Page Two 
Object to complete Trigger: Set the side, country, and/or class of the object required to complete 
this destination trigger. This is not an option if Destination activation was selected on page one 
because the attached platform is the default object to complete the trigger.  

9 Note: You may leave any of these fields blank, meaning that any value is valid for that field. 
For example, if you select "United States" for the country and leave the rest of the fields blank, any 
United States platform on any side can satisfy this trigger. Similarly you can set the side 
specification to side 1, and leave the rest of the fields blank. Then any platform on side 1 can 
accomplish the trigger. 

Return to Base: If the object selected in the previous option is an aircraft, select this option if part 
of the criteria to satisfy this trigger is that the aircraft return to its base after meeting all the other 
criteria in the trigger.  

The remaining options do not apply if Kill Activation was selected on page one. 

Max Speed: Set the maximum speed allowable for trigger completion. Set –1 to require no specific 
speed for trigger completion. (Destination and Approach triggers only) 

Depth Check: Select the type of depth criteria from either Min-Max Depth or On Land. If Min-Max 
Depth is selected then the following two options appear. 

Min Depth: Set the minimum depth allowable for trigger completion. Set –1 to require no 
specific minimum depth for trigger completion. If the platform is an aircraft enter the minimum 
altitude for the platform.  
Max Depth: Set the maximum depth allowable for trigger completion. Set –1 to require no 
specific maximum depth for trigger completion. If the platform is an aircraft enter the maximum 
altitude. 

If On Land is selected, then the Object must be on the terrain to satisfy the criteria. 

Page Three 
These options appear on page three for all Attached Trigger Activation types except as noted 
below: 
Use Doctrine Language: Select this option to enable the use of the Doctrine Editor to create 
doctrine expressions to further refine the event trapping conditions of this trigger. For more 
information see Doctrine Language on page 58. Doctrine Commands are defined in Appendix B: 
Trigger Doctrine Commands on p. 66  
Start/End Time: Specify the time within which the trigger must be completed. If you do not select a 
start or end time, this trigger can be accomplished at any time during the mission. (Option available 
for all trigger types.) Time Format: Days:Hours:Min  
Duration: The total time for which the criteria of the trigger must be true before the trigger will fire.  
Points: The number of points awarded the player for accomplishing this trigger. (Goal triggers 
only.) 
Damage: Designate the amount of damage that must occur for the trigger to be achieved. If 50% 
damage must be inflicted to the designated object, place 50 in the damage field. (This option is 
available for Kill Activation only.) 
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Radius: The radius in Nautical miles within which the designated object must arrive for the trigger 
to fire.  
Latitude: Displays the current latitude of the trigger object. To adjust the latitude of the trigger, type 
in a specific latitude coordinate. (Option available for Destination Activation only.) 
Longitude: Displays the current longitude of the trigger object. To adjust the longitude of the 
trigger, type in a specific longitude coordinate. (Option available for Destination Activation 
only.) 

Page Four (Use Doctrine selected) 
When Use Doctrine Language is selected on page three, page four contains the Doctrine Editor. 
Here doctrine language statements are created and combined using Boolean logic. The Doctrine 
Editor is described in Doctrine Language on p. 58. Doctrine Commands are describe in Appendix 
B: Trigger Doctrine Commands on p. 66. 

Page Four  
Communications: 
Specify the parameters of the communications message the player receives when the trigger is 
accomplished. During gameplay new communications messages are displayed in Report History 
window.  
Type: Allows the user to specify one of two types of communications: The type of message 
selected determines which Task Bar History Window displays the message during gameplay. 

Radio Message: A radio message provides further mission information or intelligence (During 
gameplay a Radio message appears in the Radio History Window in the Task Bar. Radio 
messages can only be received on subs when they are at comms depth with the radio antenna 
raised or the floating wire deployed.) 
Report: A report can be used to notify the player of game related information such as ‘You 
have completed the trigger.’ (During gameplay a Report message appears in the Crew Report 
History window on the Task Bar.) 

To: The platform selection referenced here applies to the platform that is to receive the message 
text (either radio or message) when the trigger completes. This allows you to set up multiplayer 
missions more easily. For example if you have a trigger for a FFG to hit a destination point, and 
you only want the player driving the helo to know about it, you can select the helo from this drop 
down list so only the helo receives this message and not all the players in the game. When All 
Controllables is selected here, all players in the game, regardless of side, receive the message. If 
you want only the platform that triggers the goal is to be notified, select the same platform here as 
was selected in Applies To on page one. 

Text: Compose the text of the communications.  

Audio File: Specify a .wav file to be played when the message is displayed. Files should be in 
.wav format; 16 bit, mono, 22 kHz.  

To play your own custom .wav file, copy the .wav file to the Scenario directory (a subdirectory off 
of the path in which S.C.S. - Dangerous Waters was installed) on your hard drive. Enter the name 
of this new .wav file in the trigger Audio File box. 

9 Note: When creating text or sound for the final trigger of the game (i.e., the Mission Complete 
trigger), make sure that the communication message tells the player that the mission has been 
completed. Missions have no other time limit or ending point. 

9 Note: When designing multiplayer missions that have custom .wav files, participating players 
must have not only the scenario file but also the new .wav file(s). The other players should copy the 
.wav and scenario files to their Scenario directory. 
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Page Five 
Trigger Complete Message: Enter a message that will appear in a pop up dialog box when the 
trigger is selected in the debrief screen if the trigger is completed.  

Trigger Incomplete Messages: Enter a message that will appear in a pop up dialog box when the 
trigger is selected in the debrief screen if the trigger is not completed.  

When the mission ends, the player reaches the Debrief screen where all the statistics of the 
mission are displayed. On this screen, all goal triggers are shown, along with their complete or 
incomplete status. If the trigger was successfully completed, clicking on the trigger name in the 
Debrief screen reveals the Trigger Complete message for that trigger. If the trigger was not 
accomplished, clicking on the trigger description displays the Trigger Incomplete message for the 
trigger.  

Page Six 
Action 
Determine an action that takes place when the trigger is reached. The following options appear in 
the Action Drop-down list. 

None: No action takes place. 

Create Objects: When this option is selected the following buttons appear in the panel. 

Add Group: Click to display the Add Group Dialog. A Group must already exist. When this 
trigger is triggered the group whose name is selected here is created. 
Delete Group: Select a group name in the Objects to Create list and click this button to delete 
the selected group from the creation list. 

9 Note: It is important that any group that is created by a trigger be given an inclusion probability 
of zero. This will ensure that this dynamic group will not be created when the scenario starts and 
will only be created when the trigger is triggered. 

Remove Attached Object 

When using an Approach Trigger to pick up pilots and Special Forces you must use this option to 
remove the pilot or Special Forces object from the map once the trigger is triggered. 

Run Script: When this option is selected a Script to Run option will appear. Select the script to 
run. A script must already exist. When this trigger is triggered the script whose name is selected 
here is run. 

TRIGGER PRECEDENCE 
In the Trigger Precedence Dialog, you define the order in which you want your triggers to be 
accomplished. If the triggers are completed out of order, the player does not receive credit for 
completing them. For example: suppose you want to create a mission in which the player must 
navigate his sub to a specific point close to shore and then destroy a building with a Tomahawk 
strike. For stealth reasons, the player must arrive at a destination trigger near the shore before 
completing the Attached Kill Trigger on the land site. In the Trigger Precedence dialog you should 
make the Destination Trigger a child trigger of the Kill Trigger. This means that the Destination 
Trigger must be accomplished first. The Kill Trigger can only be completed after the Destination  
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Trigger is completed or no credit is given to the player for the kill. 

To set Trigger Precedence: 

1. From the Editor menu, select Options>Trigger Precedence. The Trigger Precedence dialog box 
appears. 

2. All triggers in the mission are stored in the Root folder in the list to the left. 
3. Click the + in front of the Root Folder to open it. A list of the triggers appears. 
4. To make a trigger (G1) achievable only after another trigger (G2) has been reached, click the 

second trigger (G2) and drag it onto the first trigger (G1), making (G2) a child of (G1). Now, 
(G1) cannot be accomplished unless (G2) is achieved first. 

9 Note: The Trigger Precedence dialog shows the triggers in a reverse hierarchical tree. In other 
words, the child triggers must be accomplished before the parent triggers in order to maintain the 
correct order of completion. 

 

Mission Creation Tip: Use Trigger Precedence to make a “mission complete” trigger to inform the 
player when the mission is finished. To do this, create a “mission complete” Automatic Trigger that 
has an Intel message notifying the player that the mission has ended. In the Trigger Precedence 
dialog, make all other triggers in the mission children of the “mission complete” trigger. When all 
the triggers in the mission are completed, “mission complete” trigger is automatically triggered and 
informs the player the mission has ended. 
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SCRIPTS 
A script consists of several commands that the mission creator would like to execute. Once 
created, a script can be assigned to a trigger to force the action to occur at the desired time, 
location, or event. This allows actions to be executed on demand that normally would not occur 
unless certain conditions were met in the simulation. For example, a script can be used to cause an 
object to detonate without having to force another object to attack it. A script can be used to set the 
course and speed of an AI driven platform, overriding the AI commands. Scripts can be set to 
execute when a trigger is fired or when a waypoint is reached. For a list and description of available 
script commands, see Appendix C: Scripts on p. 68. 

THE SCRIPT CREATOR 
The Script Creator interface is found on page 2 of the Script Object Properties Panel. When the 
creator appears it consists of the Script Command Selection Button in an upper panel (labeled “1.”) 
and the EndScript button in a lower panel labeled “2.” What appears next is determined by the 
Script command you select from the list and what is selected on page one. You can use the 
interface from the Object Properties Panel, or click the + in the upper right of the title bar to expand 
the script creator. As you add expressions to your script, it is better to work in the expanded script 
creator 
Script Command Button                                          Expand Creator 
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It is not realistic to try to describe all of the possible permutations one can encounter using the 
Script Creator. Depending on what is selected in the Apply Script To drop-down list on page one, 
options appear, or don’t appear, when a script option is selected on Page two. For instance, if ALL 
is selected on page one of the Object Properties Panel, and DamageSystem is selected via the 
script button in the upper panel on page 2, then the second drop-down list in the upper panel is 
blank. The Script Creator doesn’t know what systems to list. If, however, a specific platform is 
selected in the Apply Script To drop-down list, the systems of that specific platform appear for 
selection in the second drop-down list on page 2 when DamageSystem is selected. 
Some Script selections result in one, two or more additional selection windows. Most are self-
explanatory. If the selected Script option on Page two results in a blank drop-down list in the 
following field(s), then the Script option is not appropriate for the object selected in Apply Script To 
drop-down list on page one. 

 

 

Expand Creator 
Script Command Button   
 
Selection fields 
 
 
 
 
 
 
 
 
 
 

 
Click to test for missing logic 
 
 
 

 
Error Status Readout 

Mission Creation Tip: From the Editor menu select Options>Preferences and be sure that the 
Use Browser ToolTips option is selected. Hold the Cursor over each button or field in the Script 
Creator for a description of its functionality. 

 TO CREATE A SCRIPT 
1. Click the Script Object Button in the lower right of the screen. When the button is clicked, the 

Script Object Properties Panel appears. There is no map object icon for a script. To view the 
Object Properties Panels for a specific script you need only select the desired script name from 
the Script Tab of the Scenario Browser. 

2. Select the platform to which the Script is to be applied from the Apply Script To drop-down list. 
The selections here are ALL or any controllable platform in the mission. Be aware when 
applying scripts to a controllable platform that the player always overrides any speed, course or 
depth changes that might be applied via a script. If the script calls for an action that the player 
controls, the player can override it in a mission. Such scripts are better applied to AI platforms.  

3. Create a name for the Script that includes a keyword that will help you remember the purpose 
of the script when it comes time to assign the script to a Trigger. 
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4. Click the double right-facing arrows to move to Page two. On Page two, the Script Creator 
appears. Click the blank Script button to display the list of available script commands. All 
available Script Commands are found in Appendix C: Scripts on p.68. 

5. Select from the available options to create the completed script. 
6. Click the EndScript button to display the list of Script Commands again if you wish to add 

additional expressions to the script. A new panel appears in the “2” slot and EndScript is now 
numbered “3.” Continue to add expressions as desired.  

7. To delete a numbered expression element from the current script, select EndScript from the 
script command drop-down list. For instance, assume Script 1 has 4 expression elements. The 
EndScript button is in the # 5 position in the Script Creator. Should you decide that you do not 
want the fourth expression, click the script selection button in the # 4 position and select 
EndScript from the drop-down list. You are prompted to confirm that you want to delete all 
parts of the expression that follow. Click the check-mark. The expression that was in the #4 
position is deleted and replaced with the EndScript button.  

8. Click TEST to check for any doctrine errors. Any detected errors appear at the bottom of the 
panel. 

9. The completed script appears on the upper panel. Click the + in the upper left of the script 
panel to edit the script. Click – to close it. 

10. Your script is now available for use! A script can be  
� run from a trigger via the Action> Run Script command. See the last page of a trigger’s 

Object Properties Panel. 

� run from a waypoint. When a waypoint is attached to a platform via a tactic or the 
Add>Waypoint option in the Editor menu, you can select a script to be run when the 
waypoint is reached. 

� run from another script. RunScript is one of the Script commands available to you. By 
adding RunScript to a script you can develop a chain of scripts that fire as designed. 

Click to open Creator and edit script 

 

SCRIPT OBJECT PROPERTIES PANEL PAGES 
PAGE ONE 
Apply Script To: Only controllable platform names appear in the list. A controllable platform must 
be placed in the mission before it appears in the Apply Script To drop-down list. Select ALL to 
apply the script to all controllable platforms or select the name of a specific controllable platform 
from the list. 

Script Name: Create a unique name for your script to help you remember its function. Scripts are 
numbered by default. Naming your script makes it easier to assign it to a trigger since scripts are 
selected from a list when creating a trigger. Script names must be unique. You are prevented from 
saving your mission until all Script names are unique. 
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PAGE TWO 
“Script” Command button: This button is blank until you click it and select a Script Command 
option. Once a script has been created, selecting page two shows the completed script in the upper 
panel along with a + in the upper left. Click the + to edit the script. 
Selection Drop-down Lists and Edit Boxes: Depending on which script command is selected, 
one or more selection lists and edit boxes appear beside or below the script button. Additional text 
may be present to create the logic for the script. 
EndScript: Click this button to display the Script Command drop-down list and add further 
commands to the script. Do not click the button if you wish to end the script as it appears. If you 
add to the script, you may need to expand the creator to be able to view all expressions in the 
script. 
Doctrine Status TEST: Click TEST to check for errors in the Script created above. 
Error Status Readout: A readout of any errors detected appears below the test button.  

  Page   57



 

DOCTRINE LANGUAGE 
The Doctrine Editor further allows a mission creator to specify criteria that must be met before a 
trigger can fire. The doctrine language allows testing of detection performance, engagements, the 
existence of objects, alliances, ROE, aircraft landing and taking off, the taking of photos, and much 
more.  
The Doctrine Editor makes use of Boolean expressions and is not for the beginner. A list and 
descriptions of the available doctrine language commands are found in Appendix B: Trigger 
Doctrine Commands on p.66.  
B To access the Doctrine Editor, select Use Doctrine Language on page two or three of the 

Trigger Object Properties Panel pages.  

Tip: Make sure that you have added and defined all of the objects you need to create your trigger 
doctrine before placing the trigger and attempting to use the Doctrine Editor. 

TO CREATE DOCTRINE FOR A TRIGGER: 
1. Click the Trigger icon on the map or select the desired trigger name from the Trigger tab of the 

Scenario Browser.  
2. Go to page two or three of the Trigger Object Properties Panel and select Use Doctrine 

Language. The page number varies based on the type of goal that is selected.  
3. Click the right facing arrows to access the next page. The Doctrine Editor is on the next page 

of the Object Property Panel when Use Doctrine Language is selected. It appears with the 
name of the selected trigger selected in the top (title) row. 

  

 

 

Click to expand Editor 

Keyword (Doctrine) Selector 

 

Expression Creator. The number and type of 
fields that appear here depends on which 
Doctrine Command is selected. 

Tool Tips provide information on each field as 
appropriate for the selected Doctrine 
Command. 

 

 

 
 

Click to test for errors in expression 

 

 
 

Result of test appears here 
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4. Select the desired command from the Keyword Selector then customize the expression using 
Boolean commands as desired. 

5. To add another element to the expression, select and or or from the Boolean term drop-down. 
To remove an expression that follows the term, select then. 

6. Click the + in the upper right of the Doctrine Editor to expand the creator window. 

Doctrine Editor in Expanded view 
 

7. Click the TEST button to check for doctrine errors. 
8. Click the + in front of a contracted expression open it for editing.  

      Click to edit expression. 
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9. Once the doctrine is enabled on a given trigger, it applies to that trigger, in addition to the 
existing criteria. For example, if you have a destination trigger - and a doctrine that says if 
PlatformExists (688I), then the destination criteria has to be met and the doctrine language 
criteria has to be met as well - so the 688I has to exist. 
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DYNAMIC GROUPS 
Dynamic Groups can make a mission appear random and dynamic so that each time you play the 
mission the situation and gameplay are different. Missions can be designed so that only some of 
the Dynamic Groups are used in the scenario when the mission loads. Only those objects in the 
randomly selected Dynamic Groups appear in the mission. Therefore, when the mission starts, you 
may have different objects appear each time. 

You can designate a certain number of objects from a selected Dynamic Group to appear in the 
mission. For example, suppose you want to create a mission in which the player’s battlegroup is 
different every time he plays the game. To do this:  

1. Create a Dynamic Group called, for example, USBattleGroup. Add a Nimitz, an Arleigh Burke, 
and a Ticonderoga to the USBattleGroup. Give each one of these platforms the desired 
probability of inclusion – the probabilities do not need to sum to 100%.  

2. To ensure that at least one of the three ships appears in the mission, specify a Minimum of 1 
ship in the settings for the USBattleGroup. To ensure that no more than two ships in the group 
appear in the mission, specify a Maximum of 2 in the settings for the USBattleGroup. At 
mission start, at least one ship and at most two are randomly chosen from the three. 

You can also specify that an entire battlegroup be randomly selected when the mission starts. To 
do this, set up another Dynamic Group and call it, for example, RussianBattleGroup. This Dynamic 
Group is similar to the USBattleGroup only it contains Russian ships.  

To set up the mission so that it randomly picks between the RussianBattleGroup and the 
USBattleGroup:  

1. Create a parent group that contains both of these battlegroups. Create a group called 
ParentGroup and add the RussianBattleGroup and the USBattleGroup to it.  

2. Now make the ParentGroup’s probability of inclusion 100%, and set the Minimum to 1 and the 
Maximum to 1.  

3. Change both the USBattleGroup’s and the RussianBattleGroup’s probability of inclusion to 
50%. At mission start, either the RussianBattleGroup or the USBattleGroup is selected, each 
with an equal likelihood of occurrence.  

Triggers can also be members of Dynamic Groups, and appear in the mission only if the Dynamic 
Group is selected at mission start up. However, triggers that are members of a Dynamic Group but 
are not attached to objects within the group are always created when the Dynamic Group is 
selected. The Minimum and Maximum specifications for the Dynamic Group do not affect these 
Triggers. Conversely, triggers that are attached to objects in the Dynamic Group are not created if 
the object itself is not created at mission start. 

CREATE DYNAMIC GROUP 
To create a dynamic group:  
1. Click an object or group of objects by selecting Edit>Select Multiple Objects option from the 

Editor menu then dragging a box in the map to enclose the desired objects or by holding down 
the [Shift] key while clicking the desired objects. 

2. From the Editor menu select Options>Create Dynamic Group. The Create Group dialog box 
appears. 

3. Enter a name for the group in the Group Name field. 
4. Set the probability that the group as a whole appears at the mission’s start. 
5. Determine how many individual ships within the Dynamic Group appear at the mission’s start 

by using the Minimum and Maximum adjusters. To change the group’s set up, select 
Options>Edit Dynamic Group from the Editor menu. 
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EDIT DYNAMIC GROUP 
To edit a dynamic group:  
1. From the Editor menu’s Option menu, select Edit Dynamic Group. The Dynamic Groups dialog 

box appears. 
2. On the left, a list of created dynamic groups appears. Click the folder of the group you wish to 

edit. 
3. Adjust the group’s probability of inclusion, as well as the range of ships that are generated 

within the group at the mission’s start. 
4. In the Selected Objects box, all the objects that make up the Dynamic Group are listed. The 

Available Objects box lists all objects available for selection. These are objects that are not 
included in this or any other Dynamic Group. 

5. To add or delete an object from the Dynamic Group, click the name of the object you want to 
shift. Use the ¿ and À buttons to move the chosen object into or out of the group. 

You can use the Edit Dynamic Group function to randomly place a group on the Mission Map at the 
mission’s start. 
1. Create a Dynamic Group in a position at which it can appear in the mission. 
2. Select the entire group and create a duplicate using the Edit>Copy function in the Editor menu. 

Select Edit>Paste then click the map to paste the new group at a second location where it can 
randomly appear. 

3. Select the new group that consists of the same ships as the first. Select Options>Create 
Dynamic Group. When the Create Group dialog box appears, give the second group a different 
name. 

4. Select Edit Dynamic Group. The Dynamic Groups dialog box appears. Both groups’ folders are 
displayed in the left-hand column. 

5. Click ADD GROUP in the upper center of the box. Create a name for this new, empty group. A 
new folder appears. 

6. Click this third group. Below, in the Available Objects box, the first two groups are listed. Move 
both groups into the Selected Objects box. They now become subgroups of the third. 

7. For this third group, set Probability at 100%. Set both Minimum and Maximum settings to 1. 
8. Now set each of the two subgroups’ Probabilities to 50%. There are now two different locations 

in which the same group might appear at the start of the mission. 

9 Note: Triggers that are members of a Dynamic Group but are not attached to a specific object 
in the group are always created when the Dynamic Group is selected. The Minimum and maximum 
specifications for the Dynamic Group do not influence these triggers. Conversely, triggers that are 
attached to objects in the Dynamic Group are not created if the object itself is not created at 
mission start. 
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MISSION EDITOR HOTKEYS 

THESE HOTKEYS ARE AVAILABLE IN THE MISSION EDITOR 
[Tab] Navigates focus to the next closest visible object icon on the map.  
[ [ ] Navigates to the next waypoint of a tactic. If the currently selected icon is an 

object, this key selects the first waypoint in that object’s tactic. If the selected 
icon is a waypoint, this key selects the next waypoint.  

[ ] ] Navigates to the previous waypoint of a tactic. Similar to the above key. 
[Esc] Cancels any operation in progress and brings up the Scenario Browser.  
[Del] Deletes the currently selected object. 
[Alt] + [I] Displays USNI Information for the currently selected object. 
[Ctrl] + [C] Copy the currently selected object. 
[Ctrl]+ [V] Paste from the copy buffer. Click the map to place the copied object. 

  Page   63



 

STARTING A CREATED MISSION 
By default missions are created as Single Missions. A Single mission with more than one 
controllable platform can be played as a Multiplayer Mission. You must have selected Campaign 
Mission as the mission type in the New Mission dialog when you created the mission if the mission 
is to be a part of a Campaign. 

To start a created mission: 
1. Select Mission>Save Mission in the Editor menu to save your mission.  
2. Select Mission>Exit to return to the Main menu. 
3. In the Main menu click Missions. Single player game titles or file names appear in the Mission 

selection list 
4. Click your mission’s name, select a platform to command from the Platform Selection List, then 

click OK to begin play.  
To start other types of missions: 

� Multiplayer Mission: Any single player mission created with more that one controllable 
platform can be played as a multiplayer mission. As Host, click Mission Selection in the 
Gameroom to access the Mission Selection list, then select your title or filename from the 
list. See S.C.S. – Dangerous Waters User Manual/Multiplayer (Section 4) for information 
on hosting, joining, and playing multiplayer games.  

� Campaign Mission: From the Campaign screen select the name of your campaign mission. 
Because of the nature of a Campaign, missions must be played in order. If you want to 
play your mission out of order, change the file extension to .mu and play it as a single 
mission. 

9 Note: If you give the mission a name in the Editor menu’s Options>Set Mission Name dialog 
that mission name appears in the Mission Selection list. If you do not set a name for the mission, 
the mission’s filename appears in the Mission Selection list. 
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APPENDIX A: TACTICS 
 
Every platform in a mission must be assigned a tactic. The desired tactic is assigned to an 
individual platform on page one of the selected object’s Object Properties Panel pages in the 
Tactics field. Each AI controlled platform follows its assigned search tactic until a detection is made 
by the platform or an allied platform. Upon detection, the Commander AI evaluates the detection 
and may order the platform to conduct further tactical maneuvers. Depending on the situation and 
the initial search tactic, the Commander AI may also elect to continue the initial search tactic. The 
tactics available in S.C.S. – Dangerous Waters are described below. 
 

1. Area Waypoints - The platform travels to each of four waypoints in sequential order. The 
waypoints may be dragged to any position on the map. Unlike transit search, when the 
platform reaches the last waypoint, it returns to the first waypoint and resumes the pattern.  

2. Barrier - The platform travels back and forth along an assigned path. The waypoint marker 
that appears on the map can be moved to any position. 

3. Expanding Box - The platform first patrols the area in an outward spiral box pattern then an 
inward spiral box pattern.  

4. Ladder Box - The platform patrols the area in a back-and-forth pattern within the 
parameters of the box. The platform reverses direction upon reaching the opposite side of 
the box. 

5. Perimeter Box - The platform patrols along the perimeter of the box. 
6. Random Box - The platform patrols the area in a random pattern. 
7. Transit - The platform travels to each waypoint. It does not deviate from its path except in 

defense. Four waypoints appear which can be dragged to any position on the map. At the 
last waypoint, the platform maintains the assigned course and speed indefinitely. 

8. Transit Search - The platform travels to each of the four waypoints. If a detection is made, 
the Commander AI may have the platform deviate from the transit waypoints. The 
waypoints may be dragged to any position on the map. At the last waypoint, the platform 
maintains the assigned course and speed indefinitely unless the Commander AI assigns a 
different tactic 

9. PIM Waypoints – The same tactic as transit search, but can only be assigned to the leader 
of a ship formation. 

10. PIM Area Waypoints – The same tactic as area waypoints, but can only be assigned to the 
leader of a ship formation. 
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APPENDIX B: TRIGGER DOCTRINE COMMANDS 
The Doctrine Editor is accessed from any Trigger Object by selecting Use Doctrine Language on 
Page two or Three of the Trigger Object Properties Panel pages. The page number depends on 
which type of trigger is selected. Select Use Doctrine Language then move to the next page. The 
Doctrine Editor appears on the following page.  
While you are learning the ins and outs of the Doctrine Editor, make sure that the Use Browser 
Tool Tips option is selected in the in the Editor menu’s Options>Preferences dialog. These tips 
describe what is to be entered in each field. 
Below are the commands available for use in doctrine creation: 

1. Attack – Test whether platform1 inflicts damage on platform2 with a weapon. Any damage 
is sufficient. A kill is not required. If the weapon misses completely, the trigger will not fire. 

2. Attack Side – Same as “Attack”, except it tests against any platform of a given side.  
3. Completed Trigger – Test whether a selected trigger has been satisfied, that is the criteria 

in the trigger has been met and the trigger fired. 
4. Detect – Tests whether platform1 has detected platform2 with the specified sensor. 
5. Detect All In Group – Allows the user to check if a platform has detected all the platforms 

contained in a group. 
6. Detect Any In Group – Allow the user to check if a platform has detected at least one 

platform contained in a group. 
7. Detect Side – The user can determine if the player was detected by any platform of a given 

side.  
8. First Met Criteria – This method will return true once the criteria of a trigger is met for the 

first time.  
9. First Failed Criteria - This method will return true once the criteria of a trigger fails for the 

first time, that is, after the criteria for the goal has been met for a time less than the 
duration of the trigger. For example, suppose the player’s task is to maintain close 
proximity to a fuel tanker for 5 minutes. If the player maintains close proximity for 30 
seconds and then drifts out of position, the doctrine FirstFailed Criteria can be used to 
send a radio message to the player to inform him that he is out of range. 

10. Group Was Created – Tests whether or not a particular dynamic group was created. 
11. Is Current Controllable – Test whether the selected platform is the current player controlled 

platform. 
12. Is Detection Held Now – Tests whether a player’s controllable platform currently holds 

detection on the selected platform. 
13. Killed All In Group – Tests whether or not the player killed all the platforms in a given 

dynamic group. 
14. Kill Any In Group - Tests whether or not the player killed any of the platforms in a given 

dynamic group. 
15. Landing – Trap the event when an aircraft lands on a specific platform. 
16. Landing of class- Trap the event when an aircraft of a certain class lands on a specific 

platform.  
17. Launch DSRV – Test whether the DSRV has been launched. 
18. Launch SEALS - Test whether the SEALS have been launched. 
19. Launch UUV - Test whether a UUV has been launched. 
20. Lost Detection – Trap the event when a platform loses detection on another platform. 
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21. Met Criteria Duration – For triggers with a duration only. Returns the total elapsed time for 
which a trigger’s criteria have been met. If the trigger’s particular criteria are not currently 
met, it returns 0. 

22. Ownship Detect – Allows the scenario creator to designate the Ownship sensor that must 
pick up the contact. 

23. Ownship Detect Side – Tests if the player has detected any platform of a given side. 
24. Platform Exists – Tests whether or not a given platform is in the current scenario. This is 

particularly useful when dynamic groups are used, and several platforms may or not be 
included in a scenario based on a random draw. 

25. Platform damage – Using this doctrine, the user can trap when the damage of a particular 
platform reaches a specified percentage. 

26. Range – Tests the range between two platforms. 
27. Take off of class – Traps when a platform of a particular class takes off from a designated 

platform. 
28. Take Photo of – Traps when the user takes a picture of a specific platform in the scenario. 
29. Take Photo of Object of Class – Traps when the user takes a picture of a platform of a 

certain type. 
30. Take off – Traps when a specified platform takes off from another specified platform. 
31. Time Since Trigger Fired – Tests whether the time since the selected trigger fired is less 

than, exceeds, or equals a certain time in seconds. 
32. Trigger Refire Count – Tests when the fired count for the selected trigger is less than, 

exceeds, or equals a certain number. 
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APPENDIX C: SCRIPTS 
The Script Creator is accessed on Page two of the Script Object Properties Panel pages. While you 
are learning the ins and outs of the Script Creator, make sure that the Use Browser Tool Tips 
option is selected in the in the Editor menu’s Options>Preferences dialog  
Below are the Scripts available for use in Script Creation: 

1. Add Effect – Add Fire/Smoke, Explosion, or Water Plume special effect to a platform.  
2. Clear Alliance – Clear the alliance between Side n and Side m. 
3. Collision Avoidance – Turn off (or on) collision avoidance for the designated platform. This 

allows you to create UNREP (Underway Replenishment) scenarios. 
4. Create Group – Create a pre-defined dynamic group. 
5. Damage System - Damages a system for the given controllable. The user must select a 

controllable platform in the first page of the script options (“Apply Script To”). The user 
must select a system to damage and the duration of the damage. A duration of zero means 
the system will be damaged indefinitely. 

6. End Mission – End the mission now, exit to debrief. 
7. EndScript – End the current script. (Selecting EndScript from the drop-down list ends the 

script at this point, however it is not necessary to select EndScript from the list. Just leaving 
the EndScript button as is (not clicking on it) accomplishes the same thing. Clicking the 
EndScript button provides access to the script command drop-down list that allows you to 
add to the current script.) 

8. Engage – Script a platform to engage another platform with a specific weapon.  
9. Enter Bearing for – Creates a bearing line solution for the selected platform, on the target 

platform. You first must select the platform that will receive or hold the bearing line - this is 
the first platform you select in the script. Next you pick the platform on which you would like 
the bearing line to be generated. The next argument is the uncertainty of the bearing - this 
is the possible error for the bearing line - this is in degrees. Finally, you select whether or 
not you want a one-time bearing entered (Temporary) or a constantly updating bearing line 
reported (Persistent.) When triggered, the line of bearing appears on the Nav screen of the 
designated platform (the first one designated in the script.) 

10. Enter Solution for –Creates a solution for the selected platform, on the target platform. You 
first must select the platform that will receive or hold the solution. - this is the first platform 
you select in the script. Next you pick the platform on which you would like the solution to 
be generated. The next argument is the uncertainty of the bearing - this is the possible 
error for the solution - in yards. The uncertainty means that the solution can be inaccurate 
up this distance - so the solution will appear randomly in a circle with a radius of 
(uncertainty) yards around the actual contact. You can also designate additional elements 
of the solution (classification, course in degrees, and the speed in knots.) Finally, select if 
this is to be a one time bearing report (Temporary) or a constantly updating bearing report 
(Persistent.) When triggered, this solution appears on the Nav screen of the designated 
platform (the first one designated in the script.) 

11. Force Trigger – Force a trigger in the scenario to be fired. To use this option, the user has 
to select a trigger in the mission to force it to be fired. 

12. Launch from – Launch an aircraft from a selected platform. Used to command an aircraft to 
take off from a ship or airport or helipad. The selected platform must have been assigned 
aircraft in order to launch an aircraft. 

13. PathFinding for – Turn on and off the pathfinding algorithm for a given platform. Pathfinding 
is the look-ahead algorithm that selects course for a platform to prevent the platform from 
running aground. With pathfinding off, the platform will follow its waypoints without regard 
to land any land that might be in the way. 
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14. Play Audio - Play an audio .wav file. User created .wav files should be placed in the 
Scenario folder. 

15. Refreshloadout – Refresh the weapon/fuel loadout of a given ship. 
16. Remove Platform – Remove a platform from the scenario. Note that the platform in 

question will immediately be removed from the scenario when this script command 
executes.  

17. RepairSystem - This script repairs a system for the given controllable. The user must 
select a controllable platform in the first page of the script options (“Apply Script To”). The 
user must select a system to repair. 

18. RunScript - Execute another script in the scenario. This can be used to daisy chain several 
scripts to run one after the other. 

19. Script Off – Turns off all script control on a particular platform in the scenario. When this is 
executed, the platform will end any script actions, and return to its previous tactics. 

20. Send Message – Send a radio or report message to a controllable platform in the scenario. 
21. Set Course of – Set the course of the selected platform. Only applicable to AI units. 
22. Set Depth/Alt – Set the depth of a submarine or the altitude of an aircraft. Only applicable 

to AI units. 
23. Set IFF on – Set a particular aircraft’s IFF to civilian, friend, or none. 
24. Set Music Tempo – Set the music tempo to normal, high, or extremely high. 
25. Set ROE – Set the rules of engagement for the selected side to peacetime or wartime. 
26. Set Speed of - Set the speed of the selected platform. Only applicable to AI units. 
27. Set Alliance – Allows the user to pick two different sides to form an alliance. 
28. Set Battery – Set the battery charge level (%) for the selected diesel submarine.  
29. Set Fuel – Set the fuel level (%) of the selected platform. 
30. Stop Trigger Refire – Stop a trigger from re-firing. This only applies to triggers with the 

“Can Refire” option turned on. 
31. Suicide Attack – This script command designates a platform to perform a suicide attack or 

“kamikaze” attack on another platform.  
32. Track Platform – Instruct a platform to track (follow at close range) another platform in the 

mission. 
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